Document History

The following table provides an overview of the most important document changes.

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>2017-05-10</td>
<td>Initial Version</td>
</tr>
</tbody>
</table>
# Content

1. **SAP S/4HANA UI Technology** ................................................................. 5

2. **Getting Started** ..................................................................................... 6
   2.1 SAP Fiori UX ....................................................................................... 6
   2.2 App Types and Database Requirements .................................................. 6
   2.3 Implementation Planning ....................................................................... 9
   2.4 Required Documentation .................................................................... 10

3. **Setup of SAP Fiori System Landscape** ................................................... 12
   3.1 Deployment Options ............................................................................ 12
   3.2 Pre-Installation ................................................................................... 13
   3.3 Required Product Versions ................................................................. 14
       Downloading Product Versions ........................................................... 15
   3.4 Installation of a New Front-End Server .................................................. 16
       Specify Language Settings .................................................................. 16
       Installation of Release Information Notes ............................................ 17
       Setup of Clients .................................................................................. 17
   3.5 Using an Existing Front-End Server (Hub Deployment) .............................. 18
   3.6 Configuration Using Task Lists ............................................................... 19
   3.7 Communication Channels .................................................................. 22
       ABAP Servers: Setup of Communication .............................................. 24
       SAP Web Dispatcher: Setup of Communication .................................... 29
       User Authentication and Single Sign-On (SSO) ....................................... 34

4. **Configuration of SAP Fiori Infrastructure** .............................................. 39
   4.1 Setup of SAP Fiori Launchpad ............................................................... 39
   4.2 Create RFC Connection for Back-End Transactions (Object Pages) .......... 39
   4.3 User Assistance Settings .................................................................... 40
       Enable Context-Sensitive User Assistance for SAP Fiori Launchpad ....... 40
       Enable User Assistance for the Back-End System ................................. 44
   4.4 SAP Fiori Search .................................................................................. 45
       Setup of SAP Fiori Search .................................................................... 45
       Enable SAP Fiori Search for Multiple Systems ....................................... 48
   4.5 Enable SAP Fiori Apps for Multiple Systems .......................................... 48
   4.6 Integrating SAP Jam (Optional) ............................................................... 49
   4.7 Extended Material Number in SAP Fiori Apps ........................................ 49
   4.8 Running Apps in Standalone Mode ....................................................... 50
   4.9 Setup of SAPUI5 Application Index ....................................................... 50

5. **App Implementation** .............................................................................. 52
   5.1 User Management and Authorization ..................................................... 53
       UI Content and Authorization Concept .................................................. 53
       Recommendations for Organizing SAP Fiori UI Entities and Authorizations 56
       General Authorizations Required for SAP Fiori ..................................... 57
1 SAP S/4HANA UI Technology

With SAP S/4HANA, all new functions, features, and innovations are accessible in the SAP Fiori launchpad. Using the launchpad, you can call up all apps for which you have been granted access. These can be SAP Fiori apps, as well as apps based on Web Dynpro and SAP GUI for HTML technology.

This guide explains how to setup a front-end server including the SAP Fiori launchpad, and how to implement the individual apps.

The guide is intended for system administrators and technical consultants.
2 Getting Started

2.1 SAP Fiori UX

SAP Fiori is the new user experience (UX) for SAP software that applies modern design principles. SAP solutions, such as SAP S/4HANA, are using the SAP Fiori UX to provide a personalized, responsive, and simple user experience.

SAP Fiori UX speaks a consistent design language and makes use of a common technical infrastructure. By blurring traditional computing boundaries and by using interactive and attractive UI elements, SAP Fiori UX provides a consistent end-to-end user experience and can be used across all device types (for example, desktop, tablet, and mobile).

Organized by user roles, the SAP Fiori launchpad is the central entry hub to all SAP Fiori apps, where users access apps via tiles. Within the launchpad, there are services for navigation, personalization, single sign-on, and search. The launchpad and the tiles are flexible and can be adapted to your needs.

You can use the search in the SAP Fiori launchpad to search for business objects and for apps. For more information, see SAP Fiori Search [page 45].

Apps applying the SAP Fiori UX focus on the most critical and common activities and are designed around how people work:

- **Role-based**: Designed for you, your needs and how you work
- **Responsive**: Supports how and where you work, at any time
- **Simple**: Focuses on the important
- **Coherent**: Provides one fluid, seamless experience
- **Delightful**: Makes an emotional connection

All UIs are built using state-of-the-art technology such as HTML5 and SAPUI5. SAP Fiori apps allow you to access the most recent version of your back end data via OData services. Using previously defined roles and authorizations, you can specify which apps and which data a user is allowed to access.

More Information

For more information about the SAP Fiori launchpad, see Setup of SAP Fiori Launchpad [page 39].

2.2 App Types and Database Requirements

In SAP S/4HANA, you can use the following SAP Fiori app types:

- Apps that are launched by using an app launcher tile

  For these apps, what information is displayed and how it is displayed is defined as part of the provided app-specific content. You cannot adapt or configure the information displayed by these apps. However, in the
SAP Fiori launchpad, you can control what each user sees by grouping these apps into catalogs and groups and assigning them to roles.

Apps that are launched by using an app launcher tile can be:

- Transactional apps
  These apps let you perform transactional tasks, such as creating a leave request for an employee. They represent simplified views and interaction with existing business processes and solutions.
- Object Pages
  These apps display contextual information and key facts about central objects used in your business operations.

- Analytical apps that are launched by using a KPI tile
  Analytical apps provide insight into the real-time operations of your business by collecting and displaying analytic information and indicators, such as KPIs, directly in your browser. To do this, the analytical apps combine the data and analytical power of SAP HANA with the integration and interface components of SAP Fiori.
  You can easily create custom analytical apps that are launched by using a KPI tile by using the SAP Smart Business Modeler apps: You can use or adapt the predefined KPIs or model your own KPIs. To determine which KPIs are displayed for each user in the SAP Fiori launchpad, you can group these KPIs and assign them to roles. A generic drill-down application included in the SAP Smart Business foundation component provides access to detail views for each tile. You can use predefined templates of the drill-down application or configure this drill-down application according to your requirements.

These SAP Fiori apps are using SAPUI5 as the UI technology. In addition to that, S/4HANA contains further apps using different UI technologies than SAPUI5. These apps can be called from the Fiori launchpad and need a specific configuration. These are the following apps:

- Web Dynpro apps
  Some analytical or transactional apps use the well-established Web Dynpro UI technology. This UI technology offers floorplan patterns, which are ideal for analytical or planning purposes.
- SAP GUI for HTML apps

System Landscape

When installing apps, we recommend a Central Hub Deployment, i.e. separating the front-end components with the UI layer from the back-end components that contain the business logic and the back-end data. This deployment option has the following strategic advantages:

- Decoupling the lifecycle of the UI apps from the back end, which has these advantages:
  - Faster iterations for the UI apps
  - Changes to the UI are possible without having development authorizations in the back end.
- Single point of maintenance for UI issues, such as browser support and updated versions of SAPUI5 libraries
- Central place for theming and branding SAP Fiori apps

The following figure shows an overview of the system landscape using a Central Hub Deployment:
All apps can be accessed over the intranet, that is, inside the corporate network. When they are accessed over the Internet, that is, from outside the corporate network, make sure the access is secure. For more information, see Deployment Options [external document].

For the SAP Fiori apps, the ABAP front-end server contains the UI layer with the product-specific UI components for the products as well as SAP NetWeaver with the relevant infrastructure components. The infrastructure comprises the central UI component with the SAPUI5 control library and the SAP Fiori launchpad as well as SAP Gateway with the OData enablement.

The front-end components have access through a trusted RFC connection to the ABAP back-end server containing the business logic.

The underlying database for the ABAP front-end server must be one of the following databases:

- SAP HANA database
- SAP MaxDB
- Sybase ASE/SAP ASE

The underlying database for the ABAP back-end server must be SAP HANA database.
2.3 Implementation Planning

From the range of SAP Fiori apps, SAP supports you to choose the apps that are most relevant for your business and guides you through the implementation. This section provides an overview of tools that you can use for planning the implementation.

Discover SAP Fiori Apps with Innovation Discovery

To simplify your search for SAP Fiori apps, SAP offers a self-service providing you with innovations tailored to your business as well as comprehensive business and technical information.

Innovation discovery is a self-service tool that simplifies your search for new functionality SAP has delivered (as enhancement packages, support packages, add-ons, or improvement notes). SAP thereby bridges the gap between business needs on the one hand and technical information regarding innovations on the other. An innovation corresponds to one or several product features. Innovation discovery contains only SAP Business Suite innovations.

If Maintenance Planner information is available for an SAP Fiori app, you can access it from innovation discovery.

You access innovation discovery at apps.support.sap.com/innovation-discovery/.

For more information, see the innovation discovery help that is available from innovation discovery.

Plan the System Landscape with Maintenance Planner

Maintenance Planner is a graphical tool on SAP Support Portal to plan and prepare the maintenance of systems in your landscape. Using Maintenance Planner, you can do, for example, the following:

- Select and install new systems for SAP Fiori apps
- Choose the target version for the installation
- Understand the impact of planned changes in a system landscape
- Download the consolidated stack XML and push all the required archives to the download basket

Maintenance Planner relates to the SAP Fiori apps reference library, if available, as follows:

- Navigate to Maintenance Planner to get detailed landscape planning information.

You access Maintenance Planner at apps.support.sap.com/sap/support/mp.

For more information, see SAP Help Portal at help.sap.com/maintenanceplanner.

Find Detailed Information about SAP Fiori Apps with the SAP Fiori Apps Reference Library

With the SAP Fiori apps reference library, you explore, plan, and support implementing SAP Fiori apps. For example, you can do the following:

- Discover all the SAP Fiori apps that are available, including previous versions
- Display key information for each app, including documentation and the technical data that you need to install and configure the app
- Navigate to related tools
- Download the aggregated installation and configuration data for a selection of apps

The SAP Fiori apps reference library relates to the other tools, if available, as follows:

- Navigate to innovation discovery to get more information about the app
- Navigate to Maintenance Planner to get detailed landscape planning information
- Navigate to the product availability matrix
Download data (consolidated list of launchpad catalogs, ICF nodes, OData services, and search connectors) for use in task lists for automatic configuration.


### 2.4 Required Documentation

In the following table you will find the most important documentation you require to implement your SAP Fiori System Landscape and the apps. Further documents and SAP Notes are referenced in the sections of this guide where needed.

<table>
<thead>
<tr>
<th>Document</th>
<th>Available at</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP S/4HANA &quot;SAP FIORI FOR SAP S/4HANA 1610&quot;: Release information</td>
<td>SAP Note 2356208</td>
</tr>
<tr>
<td>Installation Guide - Installation of SAP Systems Based on SAP NetWeaver 7.1 and Higher</td>
<td><a href="http://service.sap.com/sitoolset">service.sap.com/sitoolset</a> &gt; SL Toolset 1.0 &gt; Documentation &gt; System Provisioning</td>
</tr>
<tr>
<td>Document</td>
<td>Available at</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Latest UI5 Patch         | ![launchpad.support.sap.com/#/softwarecenter](launchpad.support.sap.com/#/softwarecenter)  
  Support Packages & Patches  
  By Alphabetical Index (A-Z)  
  N  
  UI Add-On for SAP NetWeaver  
  SAPUI5 Client  
  Runtime  
  SAPUI5 Client Runtime 1.00  
  [Latest Patch]  
  Related Info  
  Content Info |
3 Setup of SAP Fiori System Landscape

This system landscape applies to the intranet deployment scenario. When accessing SAP Fiori apps over the Internet, that is, from outside the corporate network, make sure the access is secure. For more information, see Deployment Options [external document].

Set up the system landscape to enable SAP Fiori before you start to implement an app.

The apps require front-end components (providing the user interface and the connection to the back end) and back-end components (providing the data). The front-end components and the back-end components are delivered in separate products and have to be installed in a system landscape that is enabled for SAP Fiori.

3.1 Deployment Options

Deployment of SAP Gateway

Recommendation

For running SAP Fiori apps, we recommend that you use a Central Hub Deployment of SAP Gateway. This means that you install SAP Gateway independent of consumer technologies in a standalone system, either behind or in front of the firewall. You therefore separate back-end components from front-end components.

We do not recommend the Embedded Deployment option. This document is entirely based on the Central Hub Deployment option.

Intranet Deployment

You can deploy SAP Fiori apps in the intranet, that is, inside your corporate network.

The SAP Fiori documentation focuses on the intranet deployment scenario.

When accessing SAP Fiori apps over the Internet, that is, from outside the corporate network, you have to perform additional tasks. For more information, see the following section Internet-Facing Deployment.

Internet-Facing Deployment

Recommendation

When setting up SAP Fiori apps for consumption from outside the corporate network, we recommend that you deploy SAP Web Dispatcher in the demilitarized zone (DMZ).
Recommendation

In addition, we highly recommend using Web Application Firewall capabilities in SAP Web Dispatcher or using an additional Web Application Firewall as first line of defense, especially when consuming SAP Fiori analytical apps or search capabilities over the Internet.

SAP Web Dispatcher should only forward requests to services in the internet communication manager that are necessary to run SAP Fiori apps.

There are services to run the SAP Fiori launchpad and services to run the specific apps:

- For the services to run the SAP Fiori launchpad, see SAP Help Portal at help.sap.com/s4hana_op_1610_002 ➔ SAP NetWeaver for SAP S/4HANA ➔ Function-Oriented View ➔ UI Technologies in SAP NetWeaver ➔ SAP Fiori Launchpad ➔ Administration Guide ➔ Initial Setup of the Launchpad ➔ Configuring ICF Nodes ↪.

- For the services to run the specific apps, see the app-specific documentation.

For an internet-facing deployment of mobile devices, you can use the SAP Mobile Platform Server. SAP Mobile Platform Server is an open, standards-based application server that provides a suite of services for mobile applications. By integrating SAP Mobile Platform Server into your SAP Fiori system landscape, you can create a secure, efficient, and easy-to-manage mobile environment for SAP Fiori.

More Information

For more information about SAP Mobile Platform Server, see Integration of SAP Mobile Platform into SAP Fiori Landscape at help.sap.com/s4hana_op_1610_002 ➔ Additional Information ↪.

For more information about SAP Gateway deployment options, see the SAP Help Portal at help.sap.com/s4hana_op_1610_002 ➔ SAP NetWeaver for SAP S/4HANA ➔ Function-Oriented View ➔ SAP Gateway Foundation (SAP_GWFND) ➔ SAP Gateway Foundation Master Guide ➔ Deployment Options ↪.


3.2 Pre-Installation

Before you begin to install the system landscape for SAP Fiori, make sure you have planned the following:

Network Architecture

You have to decide in which network zones the components of the SAP Fiori system landscape reside. For example, should the clients be able to access the SAP Fiori apps over the Internet, or only within the company’s intranet? Is there a demilitarized zone (DMZ) and is the SAP Web Dispatcher deployed there? Depending on your network architecture, make sure you have the right security measures in place, such as a secure firewall configuration.
Certificates for Single Sign-On

For single sign-on (SSO) using logon tickets, you require an SSL server certificate for each of the components between which you want to use SSO.

Components can be, depending on your system landscape:
- SAP Web Dispatcher
- SAP Gateway on front-end server
- ABAP back-end server

**Note**
Depending on from where you obtain the certificates, it can take several days to get them.


Browser Prerequisites

SAP Fiori apps require a web browser that can display files in HTML5 format.
For more information, see Setup of Clients [external document].

Roles and Authorizations

You have to decide how to set up the roles and authorizations for the SAP Fiori users. This includes, for example, which user group uses which apps.

For more information, see User Management and Authorization [external document].

Operating System Access for SAP HANA Database

To configure HTTPS and SSO in the SAP HANA database, the administrator requires access to SAP HANA on the operating system level.

For more information, see Operating System User <sid>adm in the SAP HANA Administration Guide at [help.sap.com/hana_platform] > System Administration.

### 3.3 Required Product Versions

**Database**
- **ABAP front-end server:**
  The underlying database for the ABAP front-end server must be one of the following databases with the following product versions:
  - SAP HANA database 1.0 (product version SAP HANA DATABASE 1.0)
  - SAP MaxDB 7.9 64-BIT (product version MAXDB 7.9 64-BIT)
  - Sybase ASE (product version SYBASE ASE 15.7 FOR BUS. SUITE) or SAP ASE (product version SAP ASE 16.0 FOR BUS. SUITE)
- **ABAP back-end server:**
  The underlying database for the ABAP back-end server must be SAP HANA database (product version SAP HANA DATABASE 1.0).
SAP FIORI FRONT-END SERVER

You require SAP Fiori front-end server 3.0 (front-end server: NW 7.50 or front-end server: NW 7.51). It contains the following components with the respective versions:

- SAP NetWeaver Gateway Foundation (software component version SAP NW GATEWAY FOUNDATION 7.50 or SAP NW GATEWAY FOUNDATION 7.51)
- User Interface Technology (software component version USER INTERFACE TECHNOLOGY 7.51)
- UI for Basis Applications (software component version UI FOR BASIS APPLICATIONS 200) - containing SAP NetWeaver Fiori Apps

For more information about the setup and configuration of SAP Fiori, see the SAP Help Portal at help.sap.com/fiori_implementation with SAP NetWeaver 7.5 or help.sap.com/fiori_implementation with SAP NetWeaver AS for ABAP 7.51 innovation package.

SAP Fiori for SAP S/4HANA

The SAP Fiori apps for SAP S/4HANA are delivered with the product SAP Fiori for SAP S/4HANA (product version SAP FIORI FOR SAP S/4HANA 1610).

3.3.1 Downloading Product Versions

You use the Maintenance Planner to download the required product versions. Maintenance Planner calculates the required software components, enables the download of archives, and creates a stack configuration file. Create a common stack configuration file for SAP Fiori for S/4HANA and SAP Fiori front-end server 3.0 to install the products in a common installation procedure.

**Note**

You cannot plan the installation of the back-end and front-end for S/4HANA in a single Maintenance Planner run. You have to do this separately and you will receive two stack configuration files, one for the front-end, and one for the back-end.

Procedure

1. You can launch Maintenance Planner as follows:
   - From the SAP Fiori apps reference library at www.sap.com/fiori-apps-library, if available for the required apps.
3.4 Installation of a New Front-End Server

This document covers the general steps to take when installing SAP Fiori apps.

Prerequisites

Pre-Installation

You have performed specific pre-installation tasks (see Pre-Installation [external document]).

Procedure

Perform the following installation tasks:

1. Download the product versions via the maintenance planner (see Required Product Versions [page 14] and Downloading Product Versions [external document]).
2. Install SAP Web Dispatcher 7.5 as the reverse proxy.
   For more information, see > help.sap.com/s4hana_op_1610_002 SAP NetWeaver for SAP S/4HANA Function-Oriented View Application Server Application Server Infrastructure Components of SAP NetWeaver Application Server SAP Web Dispatcher Administration of the SAP Web Dispatcher Operating the SAP Web Dispatcher Importing the SAP Web Dispatcher.
3. Setup of Front-End Server
   Perform the following installation tasks on the front-end server:
   1. Install SAP Fiori Front-End Server and SAP Fiori for SAP S/4HANA. For the installation, follow the instructions in the installation guide available at service.sap.com/sitoolset Software Logistics Toolset 1.0 Documentation System Provisioning Installation: Systems Based on SAP NetWeaver 7.1 and Higher.
   2. Specify the default language and the logon language.
      For more information, see Specify Language Settings [external document].
4. Install the required SAP Notes for front-end and back-end server (see Installation of SAP Notes [external document]).
5. Setup the required clients (see Setup of Clients [external document]).

3.4.1 Specify Language Settings

You must specify the settings for supported languages in the SAP Gateway system. Settings include default and logon languages.

For more information, see the SAP Help Portal at help.sap.com/s4hana_op_1610_002 SAP NetWeaver for SAP S/4HANA Function-Oriented View SAP Gateway Foundation (SAP_GWFND) SAP Gateway Foundation Configuration Guide General Configuration Settings Language Settings.
Prerequisites

You have installed the same language packages for SAP Fiori in the SAP Gateway system and the back-end system.

Activities

Default Languages

Ensure that the default language of the SAP Gateway system is the same as the default language of the back-end system, for example, English. If this is not the case, ensure that the SAP Gateway system contains a subset of the languages of the back-end system.

Logon Languages

The logon language for the ABAP application server is set according to the following process:

1. If the Mandatory Logon Data indicator has been activated for a service in transaction SICF, the system uses the language that was entered there.
2. If this is not the case, but the HTTP request contains the language in the HTTP header (as a header or a form field), you log on to the system using this language.
3. The browser settings of the calling client are then used. The system selects as the logon language the first language from the list that is maintained in the browser, and which is also installed in the SAP system. The language list is specified using the HTTP header field accept-language.

   Note
   With Internet Explorer, you can for example set the language you require by choosing Tools > Internet Options > Languages.

4. If no language is defined by this process, the classic SAP system mechanisms are used. The logon language is based on the user settings (in transaction SU01) and if nothing is entered here, the default language of the SAP system is used automatically.

3.4.2 Installation of Release Information Notes

The SAP Note 2214245 provides important overview information and links to further SAP Notes that you need to implement.

3.4.3 Setup of Clients

SAP Fiori apps are designed for both desktop and mobile device and can be used with an HTML5-capable web browser. For more information about supported combinations of device, browser and operating system, see SAP Note 1935915.
SAP created the SAP Fiori Client available for Android, iOS and Windows Phone 8.1 to provide the following assets to SAP Fiori apps running inside SAP Fiori Client:

- Additional native capabilities (such as Camera, Barcode Scanner) on top of what a typical browser provides.
- Management of the local web cache better when new versions of the application are released by the Fiori server.
- Additional security to protect the application from unauthorized access.
- Provisioning the user certificate through Mobile Secure and SAP Mobile Platform.


### 3.5 Using an Existing Front-End Server (Hub Deployment)

You can use an existing front-end server (hub) for the SAP Fiori for SAP S/4HANA installation. Existing apps continue to run against the old back-end systems while the newly installed applications of SAP Fiori for SAP S/4HANA need to be configured to run against the SAP S/4HANA system. As a prerequisite, you have to migrate the database of the central hub system and upgrade the system.

#### Implementation Considerations

SAP Fiori for SAP S/4HANA includes all apps which can be used with the corresponding SAP S/4HANA 1610 back-end system. For some areas, it updates the existing app versions on the front-end server as well. Take the following known dependencies into account when you plan the installation.

- When using one of the following UI products on the front-end server, ensure that you meet the minimum Support Package Stack level in the back-end systems of your existing landscape. As an alternative, you can also deselect these components when you plan the upgrade in the SAP Maintenance Planner.

<table>
<thead>
<tr>
<th>Product</th>
<th>Minimum Product Version and SPS level in Back-End System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master Data Governance (SAP FIORI FOR SAP MDG 1.0)</td>
<td>SAP ERP 6.0 EHP 7 SPS 09</td>
</tr>
<tr>
<td>Information Lifecycle Management (SAP FIORI FOR SAP ILM 1.0)</td>
<td>SAP NetWeaver 7.40 SPS 08</td>
</tr>
<tr>
<td>Human Capital Management (SAP FIORI FOR SAP ERP HCM 1.0)</td>
<td>SAP ERP 6.0 EHP 7 SPS 09 and SAP Fiori for SAP ERP HCM 1.0 SPS 02</td>
</tr>
</tbody>
</table>

- Not all SAP Fiori product versions installed on the front-end server are released for the new version SAP Fiori front-end server 3.0 (front-end server: NW 7.50 or front-end server: NW 7.51) to which you need to upgrade. You need to uninstall any app which is not released to be able to upgrade the front-end server. For more information, see SAP Notes [2034588](https://support.sap.com/notes) and [2200415](https://support.sap.com/notes).

- For customers running SAP Simple Finance 2.0 or lower on their front-end server, it is not possible to install the SAP Fiori for SAP S/4HANA 1610 on the same instance.

- It’s mandatory to upgrade My Inbox 100 (UIX01CA1) to My Inbox 200 (Approve Request UI 2.0).
Activities

1. Migrate your database to one of the supported database systems.
   The front-end server for SAP S/4HANA is supported on SAP HANA, SAP MaxDB, or SAP ASE as database management system. Migrate you database, if necessary.

2. If necessary, uninstall not released SAP Fiori apps. For more information, see SAP Notes 2034588 and 2011192.

3. Upgrade the front-end server to SAP Fiori front-end server 3.0 (front-end server: NW 7.50 or front-end server: NW 7.51).
   You can combine the upgrade of the front-end server and installation of SAP Fiori for SAP S/4HANA in one step. When you plan this upgrade in the SAP Maintenance Planner, the Maintenance Planner will create a common stack configuration file for all installed components.
   Proceed as described in the upgrade documentation for SAP NetWeaver 7.5 at help.sap.com/nw75/ Upgrade and Update Guides.

4. Configure the apps as described in this document and in the app-specific implementation information.

   Note
   You do not have to configure the apps of the UI products listed in the table above.

   Note
   If you move from SAP Suite on SAP HANA to SAP S/4HANA and want to make modifications you had made to the SAP HANA database visible on the UIs again, you have to carry out manual steps in different content layers.
   For more information, see Adapting Database Extensions to SAP S/4HANA [page 82]

3.6 Configuration Using Task Lists

You can perform ABAP system configuration tasks in an automated way by using predefined task lists.
For SAP Fiori, task lists support you in setting up and configuring the communication channels between the client, the front-end, and the back-end servers.

Prerequisites

- You are assigned the necessary roles to execute task lists.
  For more information, see SAP Help Portal at help.sap.com/s4hana_op_1610_002 SAP NetWeaver for SAP S/4HANA Function-Oriented View Solution Life Cycle Management SAP NetWeaver Configuration Configuration using ABAP Task Manager for Lifecyle Management Automation Standard Roles and Permissions.

Features

The following table lists the predefined task lists that are available for SAP Fiori. When you execute a task list, the system guides you through the configuration of the tasks that are included in the task list. In addition, the task list
contains documentation that describes the tasks in the task list in more detail. After executing a task list, you do not have to execute the corresponding tasks manually.

Table 4

<table>
<thead>
<tr>
<th>Task</th>
<th>Task List</th>
<th>Description</th>
<th>Related Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Gateway – Basic Configuration</td>
<td>SAP_GATEWAY_BASIC_CONFIG</td>
<td>You use this task list on the front-end server to perform basic configuration steps for SAP Gateway.</td>
<td>Activating SAP Gateway [external document]</td>
</tr>
<tr>
<td>SAP Fiori Launchpad Initial Setup</td>
<td>SAP_FIORI_LAUNCHPAD_INIT_SETUP</td>
<td>You use this task list on the front-end server to activate launchpad OData and HTTP services on an SAP Gateway system (front end).</td>
<td>Setup of SAP Fiori Launchpad [page 39]</td>
</tr>
<tr>
<td>Create Trusted Connection from SAP System to SAP Gateway</td>
<td>SAP_SAP2GATEWAY_TRUSTED_CONFIG</td>
<td>You use this task list on the back-end server to create a trusted connection from an SAP system to SAP Gateway.</td>
<td>Connect SAP Gateway to Back-End System (Trusted RFC) [external document]</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ABAP Servers: Setup of Communication [external document]</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Setting Up SSO for SAP Fiori Landscapes and S/4HANA [external document]</td>
</tr>
<tr>
<td>Note</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>You have to execute this task list in dialog.</td>
<td></td>
</tr>
<tr>
<td>Enable Embedded Search</td>
<td>SAP_ESH_INITIAL_SETUP_000_CLIENT</td>
<td>You use this task list for the automatic initial setup of Embedded Search in client 000. This task list executes the obligatory preparation steps for the implementation of Embedded Search. This can take a very long time, so start the task list in the background.</td>
<td>Setup of SAP Fiori Search [page 45]</td>
</tr>
<tr>
<td>SAP Gateway – Add Backend System</td>
<td>SAP_GATEWAY_ADD_SYSTEM</td>
<td>You use this task list on the front-end server to connect an SAP system (back end) to an SAP Gateway system (front end). The task list creates or uses an existing trusted remote function call (RFC) destination, checks the single sign-on (SSO) profile parameters, configures the SSO ticket and creates a system alias. Changes are recorded on a customizing request that you have to create or select at the beginning of the task list.</td>
<td>Creating System Alias for Applications [external document]</td>
</tr>
<tr>
<td>Task</td>
<td>Task List</td>
<td>Description</td>
<td>Related Information</td>
</tr>
<tr>
<td>------</td>
<td>-----------</td>
<td>-------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>SAP Gateway – Maintain System Alias</td>
<td>SAP_GATEWAY_ADD_SYSTEM_ALIAS</td>
<td>You use this task list on the front-end server to create a system alias for an existing remote function call destination. Configure the remote function call destination as trusted. Changes are recorded on a customizing request that you have to create or select at the beginning of the task list.</td>
<td>Creating System Alias for Applications [external document]</td>
</tr>
<tr>
<td>SAP Gateway – Activate OData Services</td>
<td>SAP_GATEWAY_ACTIVATE_ODATA_SERV</td>
<td>You use this task list on the front-end server to activate OData services for the SAP Fiori apps. OData services provide information about the app tiles to be displayed.</td>
<td>Activate OData Services for Several SAP Fiori Apps [external document]</td>
</tr>
<tr>
<td>SAP Basis – Activate HTTP Services (SICF)</td>
<td>SAP_BASIS_ACTIVATE_ICF_NODES</td>
<td>You use this task list on the front-end server to activate HTTP services (SICF) according to transaction SICF. ICF nodes provide access to web resources.</td>
<td>Front-End Server: Activate ICF Services of SAPUI5 Application [external document]</td>
</tr>
<tr>
<td>Enable Embedded Search on work clients</td>
<td>SAP_ESH_INITIAL_SETUP_WRK_CLIENT</td>
<td>You use this task list for the automatic initial setup of Embedded Search in work clients. This can take a very long time, so start the task list in the background.</td>
<td>Setup of SAP Fiori Search [page 45]</td>
</tr>
<tr>
<td>● SAP Gateway – Basic Configuration</td>
<td></td>
<td></td>
<td>help.sap.com/s4hana_op_1610_002 SAP NetWeaver for SAP S/4HANA Function-Oriented View UI Technologies in SAP NetWeaver SAP Fiori Launchpad</td>
</tr>
<tr>
<td>● SAP Fiori Launchpad Initial Setup</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Task</td>
<td>Task List</td>
<td>Description</td>
<td>Related Information</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>● SAP Gateway – Activate OData Services</td>
<td>● SAP_GATEWAY_ACTIVATE_ODATA_SERV</td>
<td>Administration Guide ≫ Initial Setup of the Launchpad ≫</td>
<td>Activating SAP Gateway OData Services and Configuring ICF Nodes.</td>
</tr>
<tr>
<td>● SAP Basis – Activate HTTP Services (SICF)</td>
<td>● SAP_BASIS_ACTIVATE_ICF_NODES</td>
<td>Administration Guide ≫ Initial Setup of the Launchpad ≫</td>
<td>Activating SAP Gateway OData Services and Configuring ICF Nodes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Small footprint and does not require any additional configuration.</td>
</tr>
</tbody>
</table>

**Procedure**

1. Decide which task list you want to execute. Refer to the table above.
2. Execute the task lists with the ABAP Task Manager for Lifecycle Management Automation, transaction STC01.
3. Display the documentation that is available in the selected task list.

**More Information**

For more information about working with task lists in general and the required authorizations, see the Technical Configuration Automation ABAP configuration guide at service.sap.com/sltoolset Software Logistics Toolset 1.0 Documentation System Provisioning Installation. Automated Initial Setup of Systems Based on SAP NetWeaver ABAP.

For more information about the task lists for SAP Fiori, see the Technical Configuration Automation SAP Fiori Frontend configuration guide at service.sap.com/sltoolset Software Logistics Toolset 1.0 Documentation System Provisioning Installation. Technical Configuration Automation ABAP Fiori.

For more information about task lists for setting up Enterprise Search, see Automatic Configuration Using Task Manager Task Lists in the SAP Library for SAP NetWeaver platform at help.sap.com/s4hana_op_1610_002 Function-Oriented View Search and Operational Analytics Enterprise Search Setting Up Enterprise Search.

3.7 **Communication Channels**

To transfer application data and security credentials within your SAP Fiori system landscape, communication between the client, the front end, and the back end is established by using different communication channels and protocols:
Communication Between Client and SAP Web Dispatcher

The client can issue the following types of requests:

- HTML requests
- OData requests
- InA search requests

SAP Web Dispatcher forwards these requests to the ABAP front-end server or to the relevant back-end server (ABAP or SAP HANA). For communication between SAP Web Dispatcher and the client, an HTTPS connection is established.

Communication Between SAP Web Dispatcher and ABAP Servers

For SAP Fiori search and transactional apps, SAP Web Dispatcher forwards the following types of requests to the ABAP front-end server and the ABAP back-end server:

- ABAP front-end server:
  - HTML requests
  - OData requests
- ABAP back-end server:
  - InA search requests (SAP Fiori search only)

For communication between SAP Web Dispatcher and the ABAP servers, HTTPS connections are established.

Communication Between ABAP Front-End and ABAP Back-End Server

Data and services from the ABAP back-end server are provided for all apps to the ABAP front-end server by using OData services.
For communication between the ABAP front-end server and the ABAP back-end server, a trusted RFC connection is established.

More Information


3.7.1 ABAP Servers: Setup of Communication

Activities

To set up the connections between SAP Web Dispatcher and the ABAP servers, you must make the following settings:

- Configure HTTP security session management for the ABAP front-end server and for the ABAP back-end server.
- Configure the ABAP front-end server and the ABAP back-end server to support SSL.
- For object pages, configure SAP Fiori Search. For more information, see Setup of SAP Fiori Search [page 45].

To set up the connection between SAP Gateway on your ABAP front-end server and the application system on your ABAP back-end server, you must make the following settings:

- Define a trust relationship between the application system on the back-end server and the SAP Gateway system on the front-end server.
- Create an RFC destination in the SAP Gateway system to the application system.
- Activate SAP Gateway on the ABAP front-end server.
- Create system aliases for applications.

Recommendation

3.7.1.1 Configuring ABAP Server Session Security

For the ABAP front-end server and the ABAP back-end server running Enterprise Search, you must activate HTTP security session management by using the transaction SICF_SESSIONS. When you activate HTTP security session management, we recommend that you activate the following extra protection for security-related cookies:

- **HttpOnly**
  This attribute instructs the browser to deny access to the cookie through client side script. As a result, even if a cross-site scripting (XSS) flaw exists and a user accidentally accesses a link that exploits this flaw, the browser will not reveal the cookie to a third party.

- **Secure**
  This attribute instructs the browser to send the cookie only if the request is being sent over a secure channel such as HTTPS. This helps protect the cookie from being passed over unencrypted requests.

Note

A token-based protection against cross-site request forgery (CSRF) is active by default in SAP Gateway and SAP HANA XS SAP Fiori OData services. It protects all modifying requests.

In addition, we recommend configuring HTTP session expiration with a reasonable timeout. To configure this, you use the profile parameter `http/security_session_timeout`.

Logout from Multiple Systems

SAP Fiori apps only support logout with the ABAP front-end server. If additional SAP Gateway systems are deployed, the corresponding HTTP sessions are not closed when the user logs out. In this case, it is important to have session expiration configured.

More Information


3.7.1.2 Configuring the AS ABAP to Support SSL

All communication between the client, SAP Web Dispatcher, and the ABAP servers is handled by using HTTPS connections. To secure these HTTPS connections, you must configure all ABAP servers to support the Secure Sockets Layer (SSL) protocol.

For more information about the steps that are required to enable SSL on the ABAP servers, see SAP Help Portal at help.sap.com/s4hana_op_1610_002 ➔ SAP NetWeaver for SAP S/4HANA ➔ Function-Oriented View.
3.7.1.3 Connect SAP Gateway to Back-End System (Trusted RFC)

In the back-end system, you must create an RFC destination to the SAP Gateway system on your front-end server and define the trust relationship between the back-end system (to be the trusting system) and the SAP Gateway system (to be the trusted system).

Note
You can perform setup tasks for SAP Fiori by using task lists that SAP delivers. A task list groups configuration tasks logically and guides you through the necessary tasks.

For an overview of all task lists and tasks for SAP Fiori, see Configuration Using Task Lists [external document].

The following task list applies for this step:
- SAP_SAP2GATEWAY_TRUSTED_CONFIG


Note
Ensure that the RFC connection is securely configured.


3.7.1.4 Managing RFC Destinations

You define remote function call (RFC) destinations from the ABAP front-end server to the ABAP back-end system(s). Additionally, define an RFC destination that has the front-end server itself as target for local RFC calls.
Prerequisites

You have created the trusted relationship because the back-end servers must already trust the front-end server. For more information, see Connect SAP Gateway to Back-End System (Trusted RFC) [external document].

Procedure

1. In Customizing for SAP NetWeaver, choose \Ui Technologies > SAP Fiori > Initial Setup > Connection Settings (Front-End Server to ABAP Back-End Server) > Manage RFC Destinations\.
2. Define the required RFC destinations.


3.7.1.5 Activating SAP Gateway

Before you can use SAP Gateway functionality, you have to activate it globally in your system. You can activate and deactivate SAP Gateway. When you deactivate it, all SAP Gateway services stop running, no consumer servers can communicate with it, and an error message is sent to any system that calls for the services.

Note

You can perform setup tasks for SAP Fiori by using task lists that SAP delivers. A task list groups configuration tasks logically and guides you through the necessary tasks.

For an overview of all task lists and tasks for SAP Fiori, see Configuration Using Task Lists [external document].

You can use the following task list to perform this step:

- SAP_GATEWAY_BASIC_CONFIG

Prerequisites

Ensure that you have installed and configured the consumer server.

You have completed the installation and post-installation configuration for SAP Gateway. For more information, see Connect SAP Gateway to Back-End System (Trusted RFC) [external document] and Managing RFC Destinations [external document].

Procedure

1. In Customizing for SAP NetWeaver, choose \Ui Technologies > SAP Fiori > Initial Setup > Connection Settings (Front-End Server to ABAP Back-End Server) > Activate SAP Gateway\.

A message displays.
2. Choose **Activate**.
   A message displays informing you of the current status.

### 3.7.1.6 Creating System Alias for Applications

An SAP system alias is needed as the logical name of a system connection, that is, you specify where the SAP system alias should point to. Depending on the SAP Gateway content scenario and your system landscape you thus set up the system alias. The system alias is the result of the routing for an inbound request on SAP Gateway. It can be a remote or a local system. If that system alias is flagged as a Local GW (Local Gateway) instance, it means that the system that is responsible for processing (managing and storing) the data of an inbound request is the local SAP Gateway instance itself.

For the SAP Fiori system landscape, you need one system alias pointing to the front-end server with the indicator **Local GW** selected. For each back-end system that you want to use, you need at least one system alias with the software version **Default**. If you use approvals in a back-end system, you need an additional system alias for task processing within the workflows used in this back-end system.

**Note**
You can perform setup tasks for SAP Fiori by using task lists that SAP delivers. A task list groups configuration tasks logically and guides you through the necessary tasks.

For an overview of all task lists and tasks for SAP Fiori, see *Configuration Using Task Lists* [external document].

The following task lists apply to this step:

- SAP_GATEWAY_ADD_SYSTEM
- SAP_GATEWAY_ADD_SYSTEM_ALIAS

**Prerequisites**

You have defined remote function call (RFC) destinations from the ABAP front-end server to all back-end servers. For more information, see *Managing RFC Destinations* [external document].

**Procedure**

1. In Customizing for SAP NetWeaver, choose **UI Technologies ➔ SAP Fiori ➔ Initial Setup ➔ Connection Settings (Front-End Server to ABAP Back-End Server) ➔ Define SAP System Alias**

2. Choose **New Entries**.

3. Create the following SAP system aliases:
   - For the front-end server: One SAP system alias with the **Local GW** indicator selected.
   - For each back-end system: One SAP system alias with the corresponding RFC destination assigned and the software version **Default**.
   - For each back-end system for which you use approval apps: One additional SAP system alias for task processing with the following parameters:
     - **Local GW**: Not selected
For Local App: Selected
○ Software Version: Select the relevant data provider, such as /IWPGW/BWF.

For more information about further settings, see SAP Help Portal at help.sap.com/s4hana_op_1610_002
SAP NetWeaver for SAP S/4HANA ➤ Function-Oriented View ➤ SAP Gateway Foundation (SAP_GWFND) ➤ SAP Gateway Foundation Configuration Guide ➤ SAP Gateway Configuration ➤ Connection Settings for the SAP Gateway Hub System ➤ Connection Settings: SAP Gateway to SAP Systems ➤ Creating an SAP System Alias

3.7.2 SAP Web Dispatcher: Setup of Communication

Activities

To set up the connection between the client and SAP Web Dispatcher, you must make the following settings:
● Configure SAP Web Dispatcher to support SSL.
● Configure the SAP Web Dispatcher server port.

To set up the connections between SAP Web Dispatcher and the ABAP servers, you must make the following settings:
● Define routing rules for SAP Web Dispatcher.
● If you use X.509 client certificates for authentication at the ABAP servers, configure a trust relationship between SAP Web Dispatcher and the ICM of the ABAP servers.

Recommendation

To ensure confidentiality and integrity of data, we recommend protecting HTTP connections by using Transport Layer Security (TLS) or Secure Sockets Layer (SSL). For information about setting up communication encryption, see the SAP Help Portal at help.sap.com/s4hana_op_1610_002 ➤ SAP NetWeaver for SAP S/4HANA ➤ Security ➤ Security Guide ➤ Network and Communication Security ➤ Transport Layer Security

3.7.2.1 Configuring Communication Channel between Clients and SAP Web Dispatcher

To facilitate communication between the browser and the different systems in the SAP Fiori system landscape, you use SAP Web Dispatcher as a reverse proxy to ensure queries from the browser are correctly directed to the appropriate system.

As SAP Fiori apps access multiple back-end systems but JavaScript code is constrained by the Same Origin Policy, all systems are exposed to the browser through the reverse proxy, which brings them into a common origin (combination of protocol, host name, and port).

Note

You can configure SAP Web Dispatcher to be able to handle a high load of incoming requests.

For more information, see the SAP Help Portal at help.sap.com/s4hana_op_1610_002 ➤ SAP NetWeaver for SAP S/4HANA ➤ Function-Oriented View ➤ Application Server ➤ Application Server Infrastructure
Prerequisites

You have implemented SAP Web Dispatcher.

Procedure

Configure SAP Web Dispatcher to Support SSL

All communication to back-end systems should be handled using HTTPS requests and SAP Web Dispatcher itself should be called using only HTTPS.

1. Open the Web Dispatcher profile sapwebdisp.pfl.

2. To configure HTTPS settings, you can copy the following source code and adapt it to your business requirements:

```
sslvssl_lib = <sapcrypto dll>
sslvserver_ssl = <pse>
sslvicm/HTTPS/verify_client = 0
sslvssl/client_ssl = <pse>
sslwdisp_ssl_encrypt = 1
sslwdisp_ssl_auth = 2
sslwdisp_ssl_cred = <pse>
ssvicm/HTTPS/forward_ccert_as_header = true
```

For more information about the parameters, see the SAP Help Portal at help.sap.com/s4hana_op_1610_002.

Configure SAP Web Dispatcher Server Port

In order to satisfy the requirement of the Same Origin Policy, all systems in an SAP Fiori app landscape have to be served by a single Web server access point. Therefore, you configure a single icm/server_port in SAP Web Dispatcher to serve all back-end systems of an SAP Fiori scenario.

1. Open the Web Dispatcher profile sapwebdisp.pfl.

2. To configure the ports, you can copy the following source code and adapt it to your business requirements:

```
icm/server_port_0 = PROT=HTTPS,PORT=443,TIMEOUT=120
```

Additional parameters needed by SAP Fiori for correct request routing:

```
wdisp/system_conflict_resolution = 1
```
3.7.2.2 Defining Routing Rules for SAP Web Dispatcher and ABAP Front End

For object pages, a connection is established between the ABAP front-end server (SAP Gateway) and SAP Web Dispatcher. You define the routing rules to the required target system to ensure that requests are directed to the correct server.

For the connection between ABAP front-end server and SAP Web Dispatcher, you need the following routing rules:

<table>
<thead>
<tr>
<th>URL Prefix</th>
<th>Target System</th>
</tr>
</thead>
<tbody>
<tr>
<td>/sap/bc</td>
<td>SAP Gateway</td>
</tr>
<tr>
<td>/sap/public</td>
<td>SAP Gateway</td>
</tr>
<tr>
<td>/sap/opu</td>
<td>SAP Gateway</td>
</tr>
</tbody>
</table>

Prerequisites

For more information about the prerequisites, see Configuring Communication Channel between Clients and SAP Web Dispatcher [external document].

Procedure

Recommendation

SAP recommends that only those requests corresponding to the services required for the applications that you want to use should be routed to the application servers.

1. Open the Web Dispatcher profile sapwebdisp.pfl.
2. Configure SAP Web Dispatcher for the SAP Gateway server.

   To configure the SAP Web Dispatcher for the SAP Gateway server, you can copy the following source code and adapt it to your business requirements.
Syntax

```
wdisp/system_0 = SID=<SID of the Gateway system>,NR=<instnot>, MSHOST=<host name of Gateway system's message server>, MS.PORT=<HTTP port of the Gateway system's message server>, SRCSRV=:443, SRCURL=/sap/opu/sap/bc/sap/public
```

### Note

The `SRCSRV` and the `CLIENT` parameter are optional. For more information about the parameters, see the SAP Help Portal at [help.sap.com/s4hana_op_1610_002](http://help.sap.com/s4hana_op_1610_002) ➔ SAP NetWeaver for SAP S/4HANA ➔ Function-Oriented View ➔ Application Server ➔ Application Server Infrastructure ➔ Components of SAP NetWeaver Application Server ➔ SAP Web Dispatcher ➔ Administration of the SAP Web Dispatcher ➔ SAP Web Dispatcher Parameters - Reference ➔ `wdisp/system_<xx>`.

If you configure multiple `wdisp/system_xx` parameters, make sure you use different indexes.

### 3.7.2.3 Defining Routing Rules for SAP Web Dispatcher and ABAP Back End

For object pages, a connection is established between the ABAP back-end server and SAP Web Dispatcher. You define the routing rules to the required target system to ensure that requests are directed to the correct server.

For the connection between ABAP back-end server and SAP Web Dispatcher, you need the following routing rules:

<table>
<thead>
<tr>
<th>URL Prefix</th>
<th>Target System</th>
</tr>
</thead>
<tbody>
<tr>
<td>/sap/es/ina</td>
<td>Back-end server where Enterprise Search is installed</td>
</tr>
</tbody>
</table>

### Prerequisites

For more information about the prerequisites, see Configuring Communication Channel between Clients and SAP Web Dispatcher [external document].

### Procedure

**Recommendation**

SAP recommends that only those requests corresponding to the services required for the applications that you want to use should be routed to the application servers.

1. Open the Web Dispatcher profile `sapwebdisp.pfl`.
2. Configure SAP Web Dispatcher for the back-end server where the Enterprise Search is installed. To configure the SAP Web Dispatcher for the back-end server where the Enterprise Search is installed, you can copy the following source code and adapt it to your business requirements:
3.7.2.4 Configuring Trust Between SAP Web Dispatcher and ABAP Servers

For initial authentication at the ABAP front-end server and authentication for search requests at the ABAP back-end server (object pages), you can use different authentication methods, including X.509 certificates. If you want to use X.509 certificates, you must set up a trusted relationship between SAP Web Dispatcher and the Internet Communication Manager (ICM) of the relevant ABAP servers.

For more information about the steps that are required to configure the trusted relationship, see the SAP Help Portal at [help.sap.com/s4hana_op_1610_002](help.sap.com/s4hana_op_1610_002).

Syntax

\[\text{wdisp/system}_1 = \text{SID}=<\text{SID of the back-end server}>, \text{MSHOST}=<\text{host name of back-end server system's message server}>, \text{MSPORT}=<\text{HTTP port of the back-end server system's message server}>, \text{SRCSRV}=*:443, \text{SRCURL}=/\text{sap/es/}, \text{CLIENT}=200\]

Note

The SRCSRV is optional. For more information about the CLIENT parameter, see SAP Note 1963456.

For more information about the parameters, see the SAP Help Portal at [help.sap.com/s4hana_op_1610_002](help.sap.com/s4hana_op_1610_002).

If you configure multiple \text{sdisp/system}_xx parameters, make sure you use different indexes.
3.7.3 User Authentication and Single Sign-On (SSO)

Overview

The authentication concept for SAP Fiori apps comprises initial user authentication on the ABAP front-end server, followed by authentication of all requests to back-end systems.

Initial Authentication

When a user launches an SAP Fiori app, the launch request is sent from the client to the ABAP front-end server by the SAP Fiori launchpad. During launch, the ABAP front-end server authenticates the user by using one of the supported authentication and single sign-on (SSO) mechanisms. We recommend setting up SSO, thereby enabling users to start SAP Fiori apps using their single, existing credentials. As a fallback option, initial authentication can be based on the users’ passwords on the ABAP front-end server. SAP provides a dedicated logon handler for form-based logon. After initial authentication on the ABAP front-end server, a security session is established between the client and the ABAP front-end server.

Authentication for Requests in the Back-End Systems

After initial authentication on the ABAP front-end server, the SAP Fiori apps and the SAP Fiori launchpad can send requests to the ABAP back-end server. For these requests to back-end servers, additional configuration of SSO mechanisms for authentication may be required.
Requests to the ABAP back-end server

Apps send OData requests through the ABAP front-end server towards the ABAP back-end server. After initial authentication, a security session is established between the client and the ABAP front-end server. OData requests towards the ABAP back-end server are then communicated securely by trusted RFC.

For search in SAP Fiori launchpad, applications send InA search requests from the client to the SAP HANA database. These requests can be authenticated with Kerberos/SPNego, X.509 certificates, or logon tickets. You can configure the ABAP front-end server to issue logon tickets after initial authentication, or you can use your existing portal to do so.

3.7.3.1 Setting Up SSO for SAP Fiori and SAP S/4HANA

For SAP Fiori landscapes with SAP S/4HANA, you must configure an single sign-on (SSO) mechanism for initial authentication on the ABAP front-end server. After initial authentication, any requests to back-end ABAP systems are communicated securely by trusted RFC.

Procedure

To set up single sign-on for a system landscape with SAP S/4HANA, proceed as follows:

1. Configure initial authentication on the ABAP front-end server.
2. Configure authentication for requests to the ABAP back-end server:
   ○ Configure a trusted RFC connection between the ABAP front-end server and the ABAP back-end server.
   ○ For search in the SAP Fiori launchpad, configure authentication in the back-end server, which processes the search requests. These requests can be authenticated with Kerberos/SPNego, X.509 certificates, or logon tickets. You can configure the ABAP front-end server to issue logon tickets after initial authentication, or you can use your existing portal to do so.

   Note

You can perform setup tasks for SAP Fiori by using task lists that SAP delivers. A task list groups configuration tasks logically and guides you through the necessary tasks.

For an overview of all task lists and tasks for SAP Fiori, see Configuration Using Task Lists [external document].

The following task list applies for this step:

- SAP_SAP2GATEWAY_TRUSTED_CONFIG

More Information

- For more information about specific SSO mechanisms for authentication, see SSO Mechanisms for SAP Fiori Apps [external document].
- For more information about how to set up a trusted RFC, see SAP Help Portal at help.sap.com/s4hana_op_1610_002
- For more information about configuring SAP Fiori search, see Setup of SAP Fiori Search [page 45].
3.7.3.2 SSO Mechanisms for SAP Fiori Apps

The following authentication and single sign-on (SSO) mechanisms are supported for SAP Fiori apps:

- Kerberos/SPNego [external document]
- X.509 Certificates [external document]
- SAML 2.0 [external document]
- Logon Tickets [external document]

3.7.3.2.1 Kerberos/SPNego

If you access SAP Fiori apps from within your corporate network, you can enable Kerberos/SPNego authentication for the ABAP front-end server. This authentication is especially recommended, if you already have a Kerberos/SPNego infrastructure in place, for example, if you use Microsoft Active Directory.

Kerberos/SPNego authentication provides the following advantages:

- It simplifies the logon process by reusing credentials that have already been provided, for example, during logon to the Microsoft Windows workstation. A separate logon to the ABAP front-end server is not required.
- It is also supported for logon to the SAP GUI. Using Kerberos for both SAP GUI and HTTP access simplifies the Single Sign-On setup within your system landscape.
- It is supported by a growing number of mobile device vendors.

During logon, Kerberos/SPNego authentication requires access to an issuing system (for example, Microsoft Active Directory). As this system is typically located within the corporate network, Kerberos/SPNego cannot be used for most internet-facing deployment scenarios. To enable Single Sign-On with Kerberos/SPNego authentication from outside your corporate network, you might have to set up a VPN connection.

Kerberos/SPNego is available with the SAP Single Sign-On product, which also provides additional authentication mechanisms, such as X.509 certificates or an SAML Identity Provider.


**Configuration**


3.7.3.2.2 X.509 Certificates

If you have implemented a public-key infrastructure (PKI) for user authentication in your organization, you can use X.509 certificates by configuring the required back-end systems (ABAP or SAP HANA) to accept X.509 certificates.

Authentication with X.509 certificates provides the following advantages:
• It does not require an issuing system during logon, which means that it works well in internet-facing scenarios.

• It is also supported for logon to the SAP GUI. Using X.509 certificates for both SAP GUI and HTTP access simplifies the Single Sign-On setup within your system landscape.

X.509 certificates must be distributed to the workstations and devices that are used to access SAP Fiori apps. For mobile devices, this distribution can be performed centrally by a mobile device management software, for example SAP Afaria.

Recommendation
As X.509 certificates remain valid for a relatively long time, we recommend that you minimize the security risk by implementing a method to revoke the certificates, for example if a mobile device is lost.

Configuration
For information about the configuration that is required for X.509 certificates, see SAP Help Portal at help.sap.com/s4hana_op_1610_002

3.7.3.2.3 SAML 2.0

If you have implemented the security assertion markup language (SAML) version 2.0 as the method of single sign-on (SSO) within your organization, you can configure the ABAP front-end server for use with SAML 2.0.

This authentication method provides the following advantages:

• It includes extensive federation capabilities, which means that it works well in scenarios with federated user domains, where trust configuration can be complicated.

• It includes extensive user mapping capabilities that enable you to map SAP users based on identity attributes, such as the SAP user name attribute or a user’s e-mail address. This means that SAML 2.0 works well for scenarios with multiple user domains.

During logon, SAML 2.0 authentication requires access to an issuing system (Identity Provider). To enable single sign-on with SAML 2.0 in internet-facing deployment scenarios that leverage its federation capabilities, you must ensure that the SAML Identity Provider is securely accessible from outside your corporate network.

Note
In the SAP Fiori system landscape, SAML 2.0 is supported only for communication with the ABAP front-end server.

Configuration
For information about the configuration that is required for using SAML 2.0, see SAP Help Portal at help.sap.com/s4hana_op_1610_002
3.7.3.2.4 Logon Tickets

For logon tickets, you must configure the ABAP front-end server to issue logon tickets. Alternatively, you can use an existing system, such as a portal, in your landscape that already issues logon tickets. In addition, you must configure the required back-end systems (ABAP or SAP HANA) to accept logon tickets. You must also ensure that users in the ABAP system have the same user names as the database users in SAP HANA; user mapping is not supported.

As logon tickets are transferred as browser cookies, you can only use this authentication mechanism if all systems in your system landscape are located within the same DNS domain.

**Recommendation**

The new standardized authentication methods Kerberos/SPNego, X.509 certificates, and SAML 2.0 provide additional security and flexibility features compared to proprietary logon tickets. For example, you can define user mappings and shorten token validity periods or session lifetimes on the server. Therefore, we recommend using Kerberos/SPNego, X.509 certificates, or SAML 2.0 where technically possible.

**Note**

You can perform setup tasks for SAP Fiori by using task lists that SAP delivers. A task list groups configuration tasks logically and guides you through the necessary tasks.

For an overview of all task lists and tasks for SAP Fiori, see [Configuration Using Task Lists](#external-document) [external document].

The following task list includes a task for importing the system certificate from a remote system and adding the remote system to the Access Control List (ACL) according to transaction STRUSTSSO2:

- SAP_SAP2GATEWAY_TRUSTED_CONFIG

**Configuration**

4 Configuration of SAP Fiori Infrastructure

In this section, you set up the central SAP Fiori infrastructure before installing individual apps in your SAP Fiori system landscape.

For information on how to deploy SAP Fiori apps, also see SAP S/4HANA Fiori Apps Deployment at rapid.sap.com/bp/#/browse/categories/sap_s%4hana/areas/on-premise/packageversions/BP_S4H_UX/NWG/20/XX/2/EN/scopeitemversions/4595d0343e83404ca2e8239d5a9cfbe.

4.1 Setup of SAP Fiori Launchpad

The SAP Fiori launchpad is the entry point to the apps, from desktop and mobile devices. You need to configure the SAP Fiori launchpad so that users can access those apps that have been assigned to their respective role.

For detailed information about the configuration tasks for the SAP Fiori launchpad, see the following documentation:


Note
You can perform setup tasks for SAP Fiori by using task lists that SAP delivers. A task list groups configuration tasks logically and guides you through the necessary tasks.

For an overview of all task lists and tasks for SAP Fiori, see Configuration Using Task Lists [external document].

The following task list applies to this step:

- SAP_FIORI_LAUNCHPAD_INIT_SETUP

4.2 Create RFC Connection for Back-End Transactions (Object Pages)

From object pages, you can access the back-end server and start transactions there (in SAP GUI or Web Dynpro). To enable this, you need to establish a connection between the SAP Fiori launchpad and the back-end system. Perform the following steps on the front-end server:

Note
From mobile devices or tablets, you cannot access SAP GUI or Web Dynpro transactions through the SAP Fiori launchpad.
Procedure

1. Identify the system alias for the back-end transactions as follows:
   1. Run transaction **Overview of Launchpads (LPD_CUST)** on the front-end server.
   2. Select the relevant role with Instance **TRANSACTIONAL** and double-click it.

   **Note**
   There is a role for each front-end application. Select the front-end application that corresponds to the back end for which you want to define the RFC connection. Example: You want to establish an RFC connection that enables users to run the transaction **Display Purchase Order** in the SAP SRM back-end system. In this case, you need to select the role corresponding to the SAP SRM front-end application.

   3. In the left-hand screen area, select a row where **Transaction** is displayed as the **Application Description**. The system alias is displayed in the right-hand screen area.

2. Create an RFC connection of type **H** (HTTP connection) in transaction **Configuration of RFC Connections** (sm59).
   Use the system alias identified under 1. as the **RFC Destination**.

3. Enter the **Target Host** under **Technical Settings** in transaction **Configuration of RFC Connections** (sm59).

4.3 User Assistance Settings

The following sections describe how to enable context-sensitive user assistance for SAP S/4HANA.

4.3.1 Enable Context-Sensitive User Assistance for SAP Fiori Launchpad

To make context-sensitive user assistance available in the SAP Fiori launchpad, you need to do the settings described in the following sections:

- Configure the SAP Web Dispatcher [page 40]
- Set Up the User Assistance Plugin [page 42]

4.3.1.1 Configure the SAP Web Dispatcher

If you want to make context-sensitive user assistance available in the SAP Fiori launchpad, you must configure SAP Web Dispatcher.

Prerequisites

You have installed SAP Web Dispatcher 7.5 as the reverse proxy. For more information, see [help.sap.com/s4hana_op_1610_002](https://help.sap.com/s4hana_op_1610_002) » SAP NetWeaver for SAP S/4HANA » Function-Oriented View » Application Server »
Activities

1. Adjust the SAP Web Dispatcher profile file.
   In the sapwebdisp_pf.txt file, add the following parameters:
   - For the User Assistance Content Platform
     wdisp/system_<number> = SID=<SID1>, EXTSRV=https://cp.hana.ondemand.com:443,
     SRCURL=/sap/dfa/help/, SRCSRV=:*, PROXY=<your proxy>:<your proxy port>,
     STANDARD_COOKIE_FILTER=OFF
   - For the script server in your production system
     wdisp/system_<number> = SID=<SID2>, EXTSRV=https://xray.hana.ondemand.com:443,
     SRCURL=/resources/sap/dfa/help/, SRCSRV=:*, PROXY=<your proxy>:<your proxy port>,
     STANDARD_COOKIE_FILTER=OFF

   Note
   - Make sure that the numbers following wdisp/system_ are smaller than the numbers that you use for all your application server. The rules for the context-sensitive user assistance need to come before the rules for the application servers.
   - Make sure that the SIDs are not the same as your system IDs.

2. Activate the usage of the modification handler:
   icm/HTTP/mod_0 = PREFIX=/, FILE=$(DIR_PROFILE)/redirect.txt
   For more information about the profile parameter, see SAP Help Portal at help.sap.com/s4hana_op_1610_002

3. Adjust the SAP Web Dispatcher redirect file.
   In the redirect.txt file, add the following parameters:
   ```
   Syntax
   # User Assistance Content Platform - rewrite rule
   if %{SID} = <SID1>
   begin
   SetHeader HOST cp.hana.ondemand.com:443
   RegRewriteRawUrl ^/sap/dfa/help/(.*) /dps/$1
   end
   # Script Server - rewrite rule
   if %{SID} = <SID2>
   begin
   SetHeader HOST xray.hana.ondemand.com:443
   RegRewriteRawUrl ^/resources/sap/dfa/help/(.*) /xRayControls/resources/sap/dfa/help/$1
   ```
Note

Make sure that the SIDs in the redirect.txt file are the same as in the sapwebdisp_cf.txt file.

4. You can check if the content platform is working properly through the proxy connection by accessing:
   https://<your server>:<your port>/sap/dfa/help/odata.svc/?$format=json

   **Example**

   If the content platform is connected correctly, you can see on your screen the following output, for example:
   ```json
   {"d":{"EntitySets":
           ["Transport","DeliverableForReplication","Tile","Project","Deliverable","TransportHistory","TourIssue","ReplicationTourIssue","Hotspot","Product","Context"]}}
   ```

5. You can check if the help script server is working properly through the proxy connection by accessing:
   https://<your server>:<your port>/resources/sap/dfa/help/sap/cfg/
   XrayBootstrapHelpConfig.json

   **Example**

   If the help script server is connected correctly, you can see on your screen the following output, for example:
   ```json
   {"description":"This configuration registers the Xray bootstrap plug-in",
    "modulePaths":{
      "sap.dfa.help":"/resources/sap/dfa/help/~201509221536~"
    },
    "bootstrapPlugins":{
      "BootstrapXrayPlugin":{
        "module":"sap.dfa.help.utils.adapters.fiori.BootstrapXrayHelpPlugin"
      }
    }
   }
   ```

**Result**

You can access SAP Fiori launchpad with context-sensitive user assistance.

**4.3.1.2 Set Up the User Assistance Plugin**

To make context-sensitive user assistance available in the SAP Fiori Launchpad, you set up the user assistance plugin in the following way:
1. You create a catalog.
For more information about creating catalogs, see the documentation on SAP Fiori Launchpad at the SAP Help Portal under help.sap.com/s4hana_op_1610_002 ➔ SAP NetWeaver for SAP S/4HANA ➔ Function-Oriented View ➔ UI Technologies in SAP NetWeaver ➔ SAP Fiori Launchpad ➔ Administration Guide ➔ Initial Setup of the Launchpad.

2. You create a role that references the catalog.
For more information about creating roles for tile catalogs, see the documentation on SAP Fiori Launchpad at the SAP Help Portal under help.sap.com/s4hana_op_1610_002 ➔ SAP NetWeaver for SAP S/4HANA ➔ Function-Oriented View ➔ UI Technologies in SAP NetWeaver ➔ SAP Fiori Launchpad ➔ Administration Guide ➔ Initial Setup of the Launchpad.

3. You assign the role to every user that needs to access the context-sensitive user assistance.

4. In the catalog, you create a target mapping with the following values:

<table>
<thead>
<tr>
<th>Field Label</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Semantic Object</strong></td>
<td>Shell</td>
</tr>
<tr>
<td><strong>Action</strong></td>
<td>plugin</td>
</tr>
<tr>
<td><strong>Application Type</strong></td>
<td>SAPUI5 Fiori App</td>
</tr>
<tr>
<td><strong>Title</strong></td>
<td>User Assistance Plugin</td>
</tr>
<tr>
<td><strong>URL</strong></td>
<td>/resources/sap/dfa/help/utils/adapters/fiori</td>
</tr>
<tr>
<td></td>
<td>This requires that the SAP Web Dispatcher is set up accordingly so that this URL is routed to the script server.</td>
</tr>
<tr>
<td><strong>Component</strong></td>
<td>sap.dfa.help.utils.adapters.fiori</td>
</tr>
<tr>
<td><strong>Information</strong></td>
<td>User Assistance Plugin, relevant for all app users</td>
</tr>
<tr>
<td><strong>Device Types</strong></td>
<td>Select your required devices:</td>
</tr>
<tr>
<td></td>
<td>• Desktop</td>
</tr>
<tr>
<td></td>
<td>• Tablet</td>
</tr>
<tr>
<td></td>
<td>• Phone</td>
</tr>
<tr>
<td><strong>Parameters</strong></td>
<td>Enter the following parameters in the table:</td>
</tr>
<tr>
<td></td>
<td>• Name: <strong>product</strong> Default Value: <strong>SAP_S4HANA_ON-PREMISE</strong></td>
</tr>
<tr>
<td></td>
<td>• Name: <strong>version</strong> Default Value: 1610 002</td>
</tr>
<tr>
<td></td>
<td>• Name: <strong>editor</strong> Default Value: false</td>
</tr>
</tbody>
</table>

After you have made these setting, the user assistance icon is available for the SAP Fiori Launchpad.
4.3.2 Enable User Assistance for the Back-End System

Enable Context-Sensitive User Assistance

You need to do these settings in the back-end system which you use to create your system configuration setting. After you have done the settings, you save them, create a transport for them and transport them to your productive system(s).

Proceed as follows:
2. Select the tab PlainHtmlHttp.
3. Choose New Entries.

You have to create new entries for both documentation and XML documentation areas. To create entries for the documentation area, enter the following values:

Table 8

<table>
<thead>
<tr>
<th>Name</th>
<th>Value to be entered</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variant</td>
<td>Enter a name for the variant (any name).</td>
</tr>
<tr>
<td>Platform</td>
<td>Select the platform relevant for your implementation, for example, WN32.</td>
</tr>
<tr>
<td>Area</td>
<td>Select Documentation. This will display as IWBHELP in the table.</td>
</tr>
<tr>
<td>Server Names</td>
<td><a href="https://cp.hana.ondemand.com">https://cp.hana.ondemand.com</a></td>
</tr>
<tr>
<td>Path</td>
<td>dps/d/ahp/1610%20002</td>
</tr>
<tr>
<td>Language</td>
<td>Select the language you need.</td>
</tr>
</tbody>
</table>

To create entries for the XML documentation area, enter the following values:

Table 9

<table>
<thead>
<tr>
<th>Name</th>
<th>Value to be entered</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variant</td>
<td>Enter a name for the variant (any name).</td>
</tr>
<tr>
<td>Platform</td>
<td>Select the platform relevant for your implementation, for example, WN32.</td>
</tr>
<tr>
<td>Area</td>
<td>Select XML Documentation. This will display as XML_DOCU in the table.</td>
</tr>
<tr>
<td>Server Names</td>
<td><a href="https://cp.hana.ondemand.com">https://cp.hana.ondemand.com</a></td>
</tr>
<tr>
<td>Path</td>
<td>dps/d/ahp/1610%20002</td>
</tr>
<tr>
<td>Language</td>
<td>Select the language you need.</td>
</tr>
</tbody>
</table>

4. Repeat step 3 for each relevant platform and language.
5. Select one entry as default per platform.
6. Save your changes and create a transport.
Enable Product-Specific User Assistance

After you have done the settings in transaction sr13 described above, you need to enable the product-specific User Assistance with the program rsiwbh04 in transaction se38:

1. Open transaction se38.
2. Enter the program name rsiwbh04 in the Program field and open the program.
   ○ Class must be XDP_STRUCT.
   ○ The radio button Change must be selected.
4. Run the program.

4.4 SAP Fiori Search

SAP Fiori search enables users to search for business objects across the SAP S/4HANA system and to search for apps in the SAP Fiori Launchpad.

It uses the SAP Enterprise Search on HANA. With SAP HANA as a basis, the search directly accesses transactional database tables.

SAP HANA-enabled search models are available for important business objects. They have a simple, table-based structure, which enables a high performance in the determination of search results.

You can call up object pages from the results of the SAP Fiori search to display details about the objects found and to navigate to their related object, to transactional apps. You can also access back-end transactions through object pages (from desktop devices only).

More Information

Setup of SAP Fiori Search [page 45]

4.4.1 Setup of SAP Fiori Search

You can use the SAP Fiori Search [page 45] to find apps and central business objects. To enable the SAP Fiori search in the SAP Fiori launchpad, perform the steps described below. The search for business objects is enabled through corresponding search models.

SAP Fiori Search and Object Pages

The object page app does not require search models to work. However, if you want to start the app from search, you must activate the underlying search connectors.

Note

The setup of SAP Fiori search is a prerequisite for the use of object pages.
SAP Fiori object pages for business objects provide information on top of what is displayed in the search results. Furthermore, they enable you to navigate to object pages of related business objects and to transactional apps, or to access back-end transactions, and you can drill down into a business object’s details.

Note
You can perform setup tasks for SAP Fiori by using task lists that SAP delivers. A task list groups configuration tasks logically and guides you through the necessary tasks.

For an overview of all task lists and tasks for SAP Fiori, see Configuration Using Task Lists [external document].

The following task lists apply for this step:
- SAP_ESH_INITIAL_SETUP_000_CLIENT
- SAP_ESH_INITIAL_SETUP_WRK_CLIENT

Activities

Setup of SAP Fiori Search in the Front End
You must have set up the communication between SAP Web Dispatcher and the ABAP servers. For more information, see:
- ABAP Servers: Setup of Communication [external document]
- SAP Web Dispatcher: Setup of Communication [external document]

Setup of SAP Fiori Search in the Back End
You must have set up the Enterprise Search technology. The setup process consists of the following main steps:

1. Implement SAP Notes
   Implement the SAP Notes listed in the Release Information for SAP Enterprise Search in SAP Fiori, see SAP Note 2228932.

2. Set secondary database connection for search to SAP HANA database
   Make this setting in Customizing for your back-end system under Cross-Application Components > General Application Functions > HANA-Based Search for SAP Business Suite > Configure Indexing > Set TREX/BWA Destination or SAP HANA DB Connection.
   Alternatively, you can use report ESH_ADM_SET_TREX_DESTINATION to set the database connection.

   Prerequisites:
   ○ You have created a second database connection in transaction DBCO.
   ○ A database user not equal to SAP<SID> is available. Database users must have the following authorizations:
     ○ Object authorizations TREXVIADBSL and TREXVIADBSLWITHPARAMETERS
     ○ Scheme authorization SELECT for the _SYS_REPO scheme.
     ○ Scheme authorizations SELECT, ALTER, and INDEX for the SAP<SID> scheme.
   For more information, see SAP Help Portal at help.sap.com/s4hana_op_1610_002>

3. Activate connector-based authorization checks
   To restrict the search results to the business object instances a user is authorized to see, Enterprise Search supports authorizations based on business object instances. In addition, authorization checks based on
Create connectors

SAP NetWeaver for SAP S/4HANA

Search models can be available in different components: In their original component, but also in higher layer components (extension components).

Once you create a search connector in an extension component, all search models from the original component are transferred into the extension component. You will therefore no longer find the search models in the original component.

For more information about connector creation, see SAP Help Portal at help.sap.com/s4hana_op_1610_002

Function-Oriented View ➤ Search and Operational Analytics ➤ Managing Search and Operational Analytics ➤ Security Guide for Search and Operational Analytics ➤ Authorizations

Activate the connector-based authorization checks in Customizing for your back-end system under Cross-Application Components ➤ General Application Functions ➤ HANA-Based Search for SAP Business Suite ➤ Search Configuration ➤ Set Parameters for Federated Search. Under Model Authorization, select Check from the dropdown menu.

4. Activate UI services

Activate the following services for the Enterprise Search in transaction Activate Service (SICF) in your back-end system:

- default_host > sap > bc > webdynpro > sap > ESH_ADMIN_UI_COMPONENT
- default_host > sap > bc > webdynpro > sap > esh_eng_modeling
- default_host > sap > bc > webdynpro > sap > esh_eng_wizard
- default_host > sap > bc > webdynpro > sap > esh_search_results_ui
- default_host > sap > bc > webdynpro > sap > wdhc_help_center
- default_host > sap > es > cockpit
- default_host > sap > es > saplink
- default_host > sap > es > search
- default_host > sap > es > ina > GetResponse
- default_host > sap > es > ina > GetServerInfo

5. Create connectors

Prerequisite: You need the following authorizations:

- SAP_ESH_SEARCH
- SAP_ESH_LOCAL_ADMIN

Create connectors in the Connector Administration Cockpit (transaction ESH_COCKPIT).

The connectors required for each object page and the relevant search software components are documented in the implementation documentation for the single object pages.

Note

Note the following system behavior:

- Search software components build a stack: On top of the basis component, different layers can be installed.
- Search models can be available in different components: In their original component, but also in higher layer components (extension components).
- Once you create a search connector in an extension component, all search models from the original component are transferred into the extension component. You will therefore no longer find the search models in the original component.

For more information about connector creation, see SAP Help Portal at help.sap.com/s4hana_op_1610_002

Function-Oriented View ➤ Search and Operational Analytics ➤ Enterprise Search ➤ Setting Up Enterprise Search ➤ Creating Connectors

Note

When search models are transported, for example in the event of a system upgrade, manual steps can be required. For more information, see SAP Help Portal at help.sap.com/s4hana_op_1610_002

© Copyright 2016 SAP SE or an SAP affiliate company. All rights reserved.
More Information

Enable SAP Fiori Search for Multiple Systems [page 48]

4.4.2 Enable SAP Fiori Search for Multiple Systems

Note
This activity is optional.

In the SAP Fiori landscape, you can connect multiple ABAP back-end servers to have the installed systems browsed by SAP Fiori search. Each back-end server must run on an SAP HANA database and must have SAP Fiori search installed and configured. One back-end server acts as a proxy to which the other back-end servers are connected. The connected back-end servers act as clients. Their content can be browsed using the SAP Fiori search on the proxy.

Activities

To enable SAP Fiori search for multiple systems, proceed as follows:

1. Set up SAP Fiori search on each of the back-end servers. For more information, see Setup of SAP Fiori Search [page 45].

2. Connect the search systems on the different back-end servers. For more information, see SAP Help Portal at help.sap.com/s4hana_op_1610_002 ▶ SAP NetWeaver for SAP S/4HANA ▶ Function-Oriented View ▶ Search and Operational Analytics ▶ Enterprise Search ▶ Setting Up Enterprise Search ▶ Optional: Establishing Connection to Back-End Systems ▶

4.5 Enable SAP Fiori Apps for Multiple Systems

If you have configured SAP Fiori search to browse the systems installed on multiple back-end servers, you can also configure SAP Fiori apps for multiple back ends. This enables you to call up the SAP Fiori apps of a business...
object listed in the search results, regardless of the system the business object resides in. While it is possible to search across multiple systems, the data displayed in the SAP Fiori app always comes from one system.

For more information about SAP Fiori search for multiple back ends, see Enable SAP Fiori Search for Multiple Systems [page 48].

**Activities**

Create system aliases in SAP Gateway.

**Note**

You require SAP NetWeaver Gateway Foundation 7.50 (software component version SAP NW GATEWAY FOUNDATION 7.50).

For more information about how to manage system aliases in a landscape with several back-end systems to retrieve data from, see SAP Help Portal at help.sap.com/s4hana_op_1610_002 \> SAP NetWeaver for SAP S/4HANA \> Function-Oriented View \> SAP Gateway Foundation (SAP_GWFND) \> SAP Gateway Configuration Guide \> Connection Settings for the SAP Gateway Hub System \> Connection Settings: SAP Gateway to SAP Systems \> System ID in Origin Segment Parameter.

**4.6 Integrating SAP Jam (Optional)**

Some SAP Fiori apps contain features based on an integration with SAP Jam. SAP Jam is a collaborative environment that brings together people, information, applications, and processes to solve business-critical problems and drive rapid results.

SAP Jam is part of the ABAP social media integration (SMI), which allows you to integrate the SAP Jam social collaboration platform across SAP technologies such as SAPUI5.

You can configure ABAP SMI to allow the SAP Fiori launchpad and apps to use the ABAP SMI functions developed for SAP Fiori.

**More Information**

For information about integrating SAP Jam with SAP Fiori and the prerequisites therefore, see the SAP Library as follows:

SAP Help Portal at help.sap.com/s4hana_op_1610_002 \> SAP NetWeaver for SAP S/4HANA \> Function-Oriented View \> UI Technologies in SAP NetWeaver \> Social Media Integration \> Information for Administrators \> Configuration \> Configuring ABAP SMI for SAP Fiori Apps.

**4.7 Extended Material Number in SAP Fiori Apps**

In SAP S/4HANA you can use the extended material number with a maximum length of 40 characters. As a default, the standard material number which allows a maximum length of 18 characters is activated. You can
activate the extended material number in the back-end system. The SAP Fiori apps then automatically display the extended material number.

Activities

If you want to use the extended material number, you have to make the following settings:

1. Activate the extended material number in the IMG under Cross-Application Components > General Application Functions > Field length Extension > Activate extended fields.
   The standard setting is that the checkbox is not selected: The system uses the short version of the material number field, for example MATNR, for all external communication.
2. Define the material number field length in the IMG under Logistics General > Material Master > Basic Settings > Define Output Format of Material Number.

4.8 Running Apps in Standalone Mode

Several SAP Fiori apps support standalone mode. If you implement this feature, users can directly access an app without the SAP Fiori launchpad being visible to them either by calling a URL or by launching the app in the SAP Enterprise Portal content area.

You typically use one of these options to give users direct access to selected apps that do not require contextual navigation.

More Information

help.sap.com/s4hana_op_1610_002 > SAP NetWeaver for SAP S/4HANA > Function-Oriented View > UI Technologies in SAP NetWeaver > SAP Fiori Launchpad > Administration Guide > Setting Up Launchpad Content > Setting Up Content With the Launchpad Designer > Setting up Navigation > Running Standalone Applications

4.9 Setup of SAPUI5 Application Index

The SAPUI5 application index provides an indexing and caching mechanism for information related to SAPUI5 applications, components, and libraries that are contained in SAPUI5 repositories on the SAP NetWeaver Application Server for ABAP.

Activities

The SAPUI5 application index is used by several different services (such as SAP Fiori launchpad and cache buster), which means you have to define the execution of its calculation report /UI5/APP_INDEX_CALCULATE as a background job (transaction SM36).
More Information

For more information, see SAP Library on SAP Help Portal at help.sap.com/s4hana_op_1610_002 > SAP NetWeaver for SAP S/4HANA > Function-Oriented View > UI Technologies in SAP NetWeaver > SAPUI5 Development Toolkit for HTML5 > Developing Apps > The SAPUI5 ABAP Repository and the ABAP Back-End Infrastructure > SAPUI5 Application Index.
5 App Implementation

This section contains the background information and the tasks that you need to perform to implement apps into the system landscape that you have set up and configured. The implementation tasks slightly differ according to the type of app that you want to use.

Prerequisites

- You have installed and configured the system landscape. For more information about the system landscape, see Setup of SAP Fiori System Landscape [external document].
- You have done the initial configuration of SAP Gateway. For more information, see SAP Help Portal at help.sap.com/s4hana_op_1610_002 ➤ SAP NetWeaver for SAP S/4HANA ➤ Function-Oriented View ➤ SAP Gateway Foundation (SAP_GWFND) ➤ SAP Gateway Foundation Configuration Guide ➤ General Configuration Settings ➤. You can also find technical information about the apps in the SAP Fiori apps reference library at fioriappslibrary.hana.ondemand.com/sap/fix/externalViewer/.
- You have set up the SAP Fiori infrastructure. For more information, see Configuration of SAP Fiori Infrastructure [page 39].

Process

1. Make yourself familiar with the user management and authorization concepts [external document] for the SAP Fiori launchpad.
2. You enable the apps to retrieve data from the back-end server.
   - For SAP Fiori apps, you need to activate OData services [external document] and ICF Services [external document] on the front-end server.
   - For Web Dynpro apps, you need to create RFC connections to the backend [page 63] on the front-end server. On the back-end server, you need to activate ICF services of Web Dynpro Apps [page 71] and activate ICF services for transactions displayed in SAP GUI for HTML [page 72].
3. You need to set up users on the front-end server [external document] and back-end server [external document].
4. You need to define what apps your users are allowed to access from the SAP Fiori launchpad on the front-end server. To do so, you do the following:
1. You create catalogs and groups [page 66] to which you add apps.
2. You create PFCG roles [external document], add catalogs to these roles, and determine the authorization defaults for the apps.
3. You assign the roles to your users [external document].
4. On the back-end server, users need the start authorizations for the Odata service or the application and the business authorizations for accessing business data displayed in the app. You therefore need to create PFCG roles on the back-end server [external document] and assign them to your users.

Note
You can also perform several app implementation tasks automatically. See the task descriptions and also see the following documentation:
- Activate Apps with SAP Fiori App Implementation Foundation [external document]
- Activate OData Services for Several SAP Fiori Apps [external document]

5.1 User Management and Authorization

SAP Fiori apps adopt the user management and authorization concepts provided by SAP NetWeaver ABAP. Therefore, the security recommendations and guidelines for user and role administration and authorization as described in the SAP NetWeaver Application Server ABAP Security Guide also apply to the SAP Fiori apps.

For more information, see help.sap.com/s4hana_op_1610_002 | SAP NetWeaver for SAP S/4HANA Security.

This section contains information about user and role administration and the authorization concept that specifically applies to SAP Fiori apps.

5.1.1 UI Content and Authorization Concept

SAP Fiori launchpad is the access point to apps on mobile or desktop devices. To use SAP Fiori apps, users need the following types of entities:
- UI: The SAP Fiori UI entities that define which SAP Fiori apps are displayed to the user. The apps are organized through catalogs and groups.
- Authorizations: The authorizations that are required to use Fiori launchpad, to start SAP Fiori apps, and to use the business logic and data of the SAP Fiori apps.

SAP Fiori UI entities and authorizations are assigned to users by means of PFCG roles. This section presents the app-specific SAP Fiori UI entities and authorizations. For general authorizations that are required for using the SAP Fiori launchpad, see General Authorizations Required for SAP Fiori [external document].

Dependencies between SAP Fiori UI Entities, OData Services, and Authorizations

The following figure shows the dependencies between the entities:
- The SAP Fiori UI entities that define which SAP Fiori apps are displayed to the user.
- The OData services that retrieve the dynamic data to be displayed from the business logic for the SAP Fiori apps.
- The authorizations required to start and to use the business logic of the SAP Fiori apps. These authorizations are defined by the OData services.

**Note**
For apps using Web Dynpro or SAP GUI for HTML technology, the picture looks slightly different. These apps do not use app-specific OData services. Instead, the access to the back-end server requires an HTTP connection. Authorizations are defined by the application itself.

### UI Entities

The apps that are displayed to the users are organized using the following SAP Fiori UI entities:

- **Catalogs**
  A catalog is a set of apps that you want to make available and authorize for your users. The users can browse through the catalog, choose apps from the catalog, and add them to the entry page of their SAP Fiori launchpad.

  Technically, apps are represented by the following:
  - KPI tiles to launch analytical apps
  - App launcher tiles to launch all other types of apps

  **Note**
  Only the apps that can be accessed directly from the entry page of the SAP Fiori launchpad have an app launcher tile. Object pages, for example, do not have any app launchers. They are started by navigating from other applications or by using the search.

  - Target mappings referencing the actual navigation targets

- **Groups**

**Figure 4: Dependencies Between UI Entities and Authorizations for SAP Fiori Apps**
Groups define the SAP Fiori launchpad entry page. The apps in the group are a subset of apps that are assigned to one or several catalogs. Which tiles are displayed on a user’s entry page depends on the catalogs and groups assigned to the user’s roles. If a group contains apps that are not assigned to the user by catalogs, the app is not displayed on the user’s entry page. In addition, if configured, the user can personalize the entry page by adding or removing apps to pre-delivered groups or self-defined group.

You maintain catalogs and groups in the launchpad designer. SAP delivers technical catalogs which contain apps per application area. In addition, SAP delivers business catalogs and business groups as sample collection of apps relevant for a business role.

As an administrator, you can use the technical catalogs as repository to create your own role-specific business catalogs and groups. For more information, see Maintain Business Catalogs and Business Groups [page 66].

PFCG Roles

You use PFCG roles to assign the UI entities and authorizations to the users:

- PFCG roles on front-end server

  By adding the catalogs to the role menu, you include the apps in the catalog that is available to the users. By adding groups, you define the SAP Fiori launchpad entry page. To start the apps, users require the start authorizations for the model provider of the activated OData services. To get these start authorizations, you add the OData services to the PFCG role menu. For the OData services the SAP Fiori app use, see the SAP Fiori app implementation documentation. If available, the system determines the OData services for a catalog and automatically includes the start authorizations when adding the catalog to the role menu.

  For more information, see Create PFCG Role on Front-End and Assign Launchpad Catalogs and Groups [external document]

- PFCG roles on the back-end server

  On the back-end server, the OData services that the SAP Fiori apps use are implemented. Therefore, the users need to have start authorization for the OData service’s data provider, and all the business authorizations for accessing business data displayed in the app.

  For object pages, the authorization defaults also include the authorizations for the Enterprise Search connectors. For Web Dynpro or SAP GUI for HTML apps, users need authorizations for the Web Dynpro applications and transactions. The OData services, Web Dynpro applications and transactions carry the authorization defaults for the business authorizations as proposed by SAP.

  To get the authorizations, you add the OData services, Web Dynpro applications and transactions for SAPGUI for HTML apps to the PFCG role menu. This adds the start authorizations and the authorization defaults for the business authorizations of the applications to the role. If available, we recommend adding the catalog to the role menu to automatically determine the OData services, Web Dynpro applications and transactions included in the catalog. With that, you can organize the update of authorizations when the catalog changes.

  In the graphic above, the dotted arrow pointing from the menu of the PFCG role on the back-end to the catalog on the front-end depicts this recommendation.

  For more information, see Create PFCG Role on Back-End [external document]

Sequence When Starting an SAP Fiori App

- When the user starts the SAP Fiori launchpad, the launchpad displays the app tiles that are assigned to users via catalogs and organized in groups.

  A launchpad-specific OData service resolves the catalogs and groups a user is assigned to: This service resolves the user’s catalog and group assignments. It uses the PFCG roles which the user belongs to on the front-end server by collecting the corresponding catalog and group entries in the PFCG role menu.
• To start an SAP Fiori app, the user chooses a tile. The tile resolves the technical SAP Fiori app implementation to be started using a target mapping.

• The tiles and target mappings of a catalog or group, which then determine the technical SAP Fiori app implementation, are maintained in the SAP Fiori launchpad designer.

• When a user’s browser loads an SAP Fiori app, the app retrieves its dynamic data from the HTTP endpoint of the app-specific OData service on the front-end server. SAP Gateway translates the HTTP request to a trusted RFC call to the Gateway enablement of the back-end server, which then retrieves the data by calling the relevant business logic.

• The user requires authorizations for the app-specific OData service, that is, the start authorizations for the service on the front-end server and in the back-end system and the business authorizations required by the business logic.

5.1.2 Recommendations for Organizing SAP Fiori UI Entities and Authorizations

Users can start all SAP Fiori apps assigned to them from catalogs. Therefore, we recommend organizing SAP Fiori UI entities and authorizations for the catalogs.

• Define the catalogs as the smallest entities that are assigned and authorized for your users.

• Derive groups from or across catalogs where required. Groups define the initial UI content on the SAP Fiori launchpad. The users can then personalize the SAP Fiori launchpad by displaying and hiding apps.

• In the PFCG roles on the front-end server and on the back-end server, keep the catalogs and the authorizations required by the apps included in the catalog together in the same roles.

• If available, from Role Maintenance (PFCG), you can determine the authorizations required for the apps in the catalog on the front-end and on the back-end server. For more information, see the SAP Help Portal at help.sap.com/s4hana_op_1610_002.

• On the front-end server, make sure to choose the Include Applications checkbox when adding a catalog to your PFCG roles. The start authorizations for the catalog are then included in the role menu as subnodes below the catalog entry.

• On the back-end system, also add the catalog to your existing or new PFCG role and make sure to choose the Include Applications checkbox. The authorization defaults for the catalog for the OData service data providers, Web Dynpro applications, and transactions for apps using SAP GUI for HTML technology, are included in the role menu as subnodes below the catalog entry. In addition, the authorization defaults delivered by SAP for these services and applications are added to the role.

• When a catalog is changed in the launchpad designer, for example, an app is added or removed, you must update authorizations in the PFCG roles which include this catalog. If you have add the catalogs with the determination of authorizations as described above (checkbox Include Applications chosen), you can determine the roles that must be adapted by using the PRGN_COMPARE_ROLE_MENU report.

In Role Maintenance (PFCG), you then compare and update the roles to reflect the authorization changes as given in the current definition of the catalog.

However, the comparison (both using the report or comparing in PFCG) does not include applications or services that you added manually to the role menu. For more information, see the SAP Help Portal at help.sap.com/s4hana_op_1610_002.
If a catalog contains apps that address several back-end servers, you need to create a PFCG role per back-end server. Consider splitting up the catalog.

Instead of creating new PFCG roles, you can also extend existing roles that fit to the scope of the catalog. You might want to extend roles already used in the back-end server. If you add the catalog and its applications and services to an existing role, the authorization proposals have to be merged with the authorization values already defined in the role. You can consider using existing roles if the following applies:

- The same users assigned to the role shall get access to all apps in the catalog.
- The business authorizations already defined in the role and those that you define for the apps in the catalog do not contradict.

### 5.1.3 General Authorizations Required for SAP Fiori

To run SAP Fiori launchpad and trigger the OData services required for SAP Fiori, users need certain general authorizations in addition to the app-specific authorizations on the front-end and the back-end server.

#### Front-End Server

Assign the following once on the SAP Fiori front-end server:

- Launchpad authorizations
  
  End users need authorizations to run the SAP Fiori launchpad; administrators need additional authorizations to run the SAP Fiori launchpad designer. SAP delivers template roles for launchpad access.


- General OData authorizations
  
  The authorizations required to use the SAP Gateway runtime. SAP delivers authorization templates for accessing the Gateway runtime.


- Trusted RFC back-end connectivity authorizations
  
  S_RFC and S_RFCACL authorizations are required for each back-end server to access the back-end server over a trusted RFC connection.

- For analytical apps that are launched by using a KPI tile:
  
  End users need authorizations for the OData service SMART_BUSINESS_RUNTIME_SRV. On the front-end server, the start authorization for the model provider of the activated OData service is required. While the authorization is required only once per user, we recommend to organize it by adding a reference to the target mapping with the action `analyzeSBKPIDetailsS4HANA` from the technical catalog.
SAP_TC_CA_SSB_COMMON to your business catalogs which contain analytical apps. By defining the roles for the catalogs as described in Create PFCG Role on Front-End and Assign Launchpad Catalogs and Groups [external document], the relevant users will get the authorization.

For modeling KPIs, users need to be assigned to the SAP Smart Business modeler apps. The business role SAP_BR_ANALYTICS_SPECIALIST contains the catalog and group provided by SAP. To run these apps, users need the authorizations for the OData service SMART_BUSINESS_DESIGNTIME_SRV. We recommend that you define a role using the SAP delivered catalog and group as described in Create PFCG Role on Front-End and Assign Launchpad Catalogs and Groups [external document].

- For analytical apps that are built using Analysis Path Framework (APF):
  - End users and key users:
    End users and key users need authorizations for all OData services used in the configuration, including those used for the step configuration, the filter resolution, the value help request, and so on, and for the service for path persistence BSANLY_APF_RUNTIME_SRV.
  - End users:
    For access to the layered repository of the SAPUI5 flexibility services, assign the authorization object /UIF/LREP to the end user’s PFCG role and select APFUSER as value for field /UIF/ROLE.
  - Key users:
    For using the APF Configuration Modeler design time app, users need to be assigned the business role SAP_BR_ANALYTICS_SPECIALIST. For access to the layered repository of the SAPUI5 flexibility services, assign the authorization object /UIF/LREP to the key user’s PFCG role and select APFADMIN as value for field /UIF/ROLE.

**Back-End Server**

Assign the following once for each back-end server:

- **Back-end connectivity authorizations**
  The S_RFC and S_RFCACL authorizations are required to access the trusted RFC on each back-end server. For more information, see Assign RFC Authorization to User [external document].

- For analytical apps that are launched by using a KPI tile:
  End users need the authorizations for the OData service SMART_BUSINESS_RUNTIME_SRV. Users who model KPIs in addition need the authorization for the OData service SMART_BUSINESS_DESIGNTIME_SRV. We recommend that you define the roles corresponding to those on the front-end server as described in Create PFCG Role on Back-End [external document].

- For analytical apps that are built using Analysis Path Framework (APF):
  - End users and key users:
    End users and key users need authorizations for all OData services used in the configuration, including those used for the step configuration, the filter resolution, the value help request, and so on, and for the service for path persistence BSANLY_APF_RUNTIME_SRV.

5.1.4 **Users in ABAP Front-End System**

The ABAP front-end server contains the central and app-specific SAP Fiori UI components including SAP Fiori launchpad and SAP Gateway. To launch SAP Fiori apps using SAP Fiori launchpad, users are required on the front-end server.
Note

Users must have the same user names and passwords on the ABAP front-end server and the ABAP back-end server. User mapping is not supported. For this purpose, you can use Central User Administration (CUA) or identity management systems.

To access SAP Fiori apps, users on the front-end server require UI content and authorizations. The corresponding PFCG roles need to be assigned to the user.

More Information

For information about the required UI content and authorizations for users on the front-end server, see UI Content and Authorization Concept [external document].

5.1.5 Users in ABAP Back-End System

The ABAP back-end system implements the business logic and provides the data for the SAP Fiori apps, Web Dynpro applications and transactions. For apps launched by users from the SAP Fiori Launchpad on the front-end server, users with the same user names are required on the ABAP back-end system. You can use your existing users in the ABAP back-end system as long as these users have the same user names in all ABAP back-end systems which implement apps you want to make available in SAP Fiori Launchpad.

Users in the ABAP back-end system require PFCG roles with certain general authorizations as well as authorizations for OData services, WebDynpro applications, and transactions.

More Information

For information about the required authorizations for users on the back-end system, see UI Content and Authorization Concept [external document].

5.2 Implementation Tasks on Front-End Server

This section contains the tasks you perform on the front-end server to implement SAP Fiori apps.

5.2.1 SAP Fiori Apps

5.2.1.1 Activate OData Services

There are several ways to activate the relevant OData services:

- You can activate the OData services for each app individually, as given below.
You can activate OData services for several apps at once, by using a task list. For more information, see *Activate OData Services for Several SAP Fiori Apps* [external document].

You can activate OData services and ICF nodes at once, by using an SAP Fiori app. For more information, see *Activate Apps with SAP Fiori App Implementation Foundation* [external document].

**Procedure**

1. Run transaction *Activate and maintain services* (`/IWFND/MAINT_SERVICE`) on the front-end server.
2. Choose *Add Service*.
3. Enter the system alias of your back-end system.
4. In the *External Service Name* field, enter the technical name of the OData service for your app without the version number.
   - For more information on the OData service per app, see the app-specific documentation.
5. In the *Version* field, enter the version number.
6. Choose *Get Services*.
7. Choose *Add Selected Services*.
8. Enter a technical name for the service in your customer namespace.
9. Assign a package or choose *Local Object*.
10. Choose *Execute* to save the service.
11. On the *Activate and maintain services* screen, check if the system alias is maintained correctly. If not, delete the alias and add the correct one.
12. Call the OData service once.

**Determining the OData service names for your apps**

- For apps delivered by SAP, see the SAP Fiori App Reference Library and the app-specific documentation.
- For analytical apps launched using a KPI tile that your company created, ask the responsible developer.
- If you want to determine the OData service name by yourself:
  - In the SAP Smart Business KPI Modeler apps, use the *KPI Workspace* app to look for the relevant KPI. The names of the KPI tile and the KPI name might differ slightly.
  - In the KPI, look for the evaluation. The evaluation contains the URL of the OData service, such as `/sap/opu/<service>`.

### 5.2.11.1 Activate OData Services for Several SAP Fiori Apps

Instead of manually activating OData services individually for each app, you can activate the OData services for several apps at once, by using a task list.
Prerequisites

- If you want to download OData services from SAP Fiori apps reference library: SAP Fiori apps reference library is available.
- Task lists for configuring SAP Fiori Apps are available

**Note**
You can perform setup tasks for SAP Fiori by using task lists that SAP delivers. A task list groups configuration tasks logically and guides you through the necessary tasks.
For an overview of all task lists and tasks for SAP Fiori, see Configuration Using Task Lists [external document].

The following task list applies to this step:
- SAP_GATEWAY_ACTIVATE_ODATA_SERV

Activities

1. Collect the names and version numbers of the OData services you want to activate.
   You can download this information from the SAP Fiori apps reference library or paste it from the app-specific implementation information.
2. Start task list SAP_GATEWAY_ACTIVATE_ODATA_SERV.
3. In the Define OData Services for Activation task, enter the OData services you want to activate:
   1. Enter the external service name or the technical service name.
   2. To use a version other than 1: Behind the service name, enter a blank and then the version number.
4. In the Select System Alias for Activation task, enter the system alias.
5. In the Select OData Services for Activation task, make sure that all services are selected that you want to activate. You can exclude some services that you do not want to activate.
   The system creates the OData service, assigns the system alias to the OData service, and activates the related ICF nodes.

More Information

For more information about SAP Fiori apps reference library, see Implementation Planning [external document].
For more information about working with task lists, see Configuration Using Task Lists [external document].

5.2.1.1.2 Activate Apps with SAP Fiori App Implementation Foundation

SAP Fiori app implementation foundation provides the App Activation tile in the SAP Fiori launchpad.
As an administrator, you can use App Activation to do the following at once, if there are OData services and ICF nodes for the apps you want to activate:
Activate OData services
Replaces manual activation in Activate and Maintain Services (/IWFND/MAINT_SERVICE).

Activate ICF nodes
Replaces manual activation in Maintain Services (SICF).

More Information

You download SAP Fiori app implementation foundation and its documentation from SAP Support Portal at
support.sap.com
Software Downloads > Installations and Upgrades > A-Z Alphabetical List of my
Products > F > SAP Fiori > SAP Fiori app implementation foundation.

5.2.1.2 Activate ICF Services of SAPUI5 Application

In addition to the central services relevant for all SAP Fiori apps, you must also activate the services for the specific apps. This is because, for security reasons, all Internet Communication Framework (ICF) services are made available in an inactive state.

Note
For security reasons, we recommend that you only activate the services for the apps you want to use.

There are several ways to activate the relevant ICF services:

- You can activate the ICF services for each app manually, as given below.
- You can activate OData services and ICF nodes at once (if the app-specific documentation mentions specific OData services), by using an SAP Fiori app. For more information, see Activate Apps with SAP Fiori App Implementation Foundation [external document].

Prerequisites

For each app, you find the technical name of the corresponding ICF service in the App Implementation documentation under Implementation Tasks.

Procedure

To activate an ICF service, proceed as follows:

1. On the front-end server, start transaction Maintain Services (SICF).
2. Press [F8].
3. Navigate to default_host > sap > bc > ui5.ui5 > sap.
4. In this node, navigate to the SAPUI5 application for your app.
5. To activate the service (SAPUI5 application), choose Service/Host > Activate.
5.2.2 Web Dynpro Apps and SAP GUI for HTML Apps

5.2.2.1 Set up RFC Connections to a Back-End System

To consume catalogs containing SAP GUI transactions and SAP WebDynpro applications from a specific back-end system, it is mandatory to configure the following two types of RFC connections to the back-end system.

- An ABAP connection (type 3) which is used to replicate app descriptors from the back-end server to the front-end server. Applications which use Web Dynpro and SAP GUI for HTML UI technology carry app descriptors which provide information required to access them from the SAP Fiori launchpad.
- An HTTP connection (type H), which is used to start Web Dynpro apps and transactions using SAP GUI for HTML and retrieve the business data.

To set up the connections, you first need to maintain a mapping table and then create the necessary RFC connections.

Procedure

Map the Connections

The business catalogs shipped by SAP contain system aliases which are used to call an app in a specific system, e.g. S4FIN or S4LO (see Maintain Business Catalogs and Business Groups [page 66]). The list of system aliases can be found in the section below. In your system landscape several system aliases may point to one and the same physical source system. To reduce administrative effort, SAP recommends to create entries in table /UI2/SYSALIASMAP. This table is used to map SAP system aliases to logical system aliases, which stand for the physical back-end systems connected to the front-end system. The logical system is resolved to a concrete RFC or HTTP connection by adding the suffix _RFC or _HTTP. If your Fiori launchpad is run in HTTPS mode, the connection needs the suffix _HTTPS. The table has the following structure:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MANDT</td>
<td>Yes</td>
<td>Client</td>
</tr>
<tr>
<td>SYSALIAS_SRC</td>
<td>Yes</td>
<td>Source System Alias</td>
</tr>
<tr>
<td>SYSALIAS_TGT</td>
<td></td>
<td>Target System Alias</td>
</tr>
</tbody>
</table>

To maintain the table, call up transaction SM30 and open the maintenance view /UI2/V_ALIASMAP.

The data model of the federation design uses the database for system connections in the ABAP standard, SM59. The mapping table is used during the following actions:

- Extraction of apps from a back-end system
  In this case, the type 3 (RFC) connection is used.
- Link resolution in the SAP Fiori launchpad runtime
  In this case, the type H (_HTTP or _HTTPS) connection is used.

Create RFC Connections

1. In the front-end system, choose Tools > Administration > Administration > Network > RFC Destinations or start transaction SM59.
2. Create an RFC connection of the type ABAP Connection and one of the type H - HTTP connection to ABAP System.

Use the following naming conventions:
- ABAP connection: `<Logical System Alias>_RFC`
- HTTP connection: `<Logical System Alias>_HTTP` or `<Logical System Alias>_HTTPS`

Recommendation
We recommend to use a HTTPS connection.

System Aliases
Make sure to create the ABAP connection with the radio button `Trusted Relationship` set to `Yes` and the mark `Current User` set to `true`.

<table>
<thead>
<tr>
<th>Name (System Alias)</th>
<th>Application Area</th>
<th>ACH</th>
</tr>
</thead>
<tbody>
<tr>
<td>NW</td>
<td>NetWeaver</td>
<td>BC</td>
</tr>
<tr>
<td>S4CA</td>
<td>Cross Applications</td>
<td>CA</td>
</tr>
<tr>
<td>S4CMD</td>
<td>Common Master Data</td>
<td>AP-MD</td>
</tr>
<tr>
<td>S4EAM</td>
<td>Enterprise Asset Management</td>
<td>PM</td>
</tr>
<tr>
<td>S4ECCSE</td>
<td>Localization</td>
<td>FI-LOC</td>
</tr>
<tr>
<td>S4EHS</td>
<td>Environment, Health and Safety</td>
<td>EHS</td>
</tr>
<tr>
<td>S4FIN</td>
<td>Financials</td>
<td>FI</td>
</tr>
<tr>
<td>S4FICA</td>
<td>Financials Contract Accounts</td>
<td>FI-CA</td>
</tr>
<tr>
<td>S4FICAX</td>
<td>IS Extension Financials Contract Accounts</td>
<td>FI-CAX</td>
</tr>
<tr>
<td>S4LO</td>
<td>Logistics</td>
<td>LO</td>
</tr>
<tr>
<td>S4MDG</td>
<td>Master Data Governance</td>
<td>CA-MDG</td>
</tr>
<tr>
<td>S4PLM</td>
<td>Product Lifecycle Management</td>
<td>PLM</td>
</tr>
<tr>
<td>S4PP</td>
<td>Production Planning</td>
<td>PP</td>
</tr>
<tr>
<td>S4PRC</td>
<td>Procurement</td>
<td>MM-PUR</td>
</tr>
<tr>
<td>S4PS</td>
<td>Project Services</td>
<td>PS</td>
</tr>
<tr>
<td>S4PSS</td>
<td>Product Safety &amp; Stewardship</td>
<td>ESH</td>
</tr>
<tr>
<td>S4QM</td>
<td>Quality Management</td>
<td>QM</td>
</tr>
<tr>
<td>S4SCM</td>
<td>Supply Chain Management</td>
<td>SCM</td>
</tr>
<tr>
<td>S4SD</td>
<td>Sales and Distribution</td>
<td>SD</td>
</tr>
<tr>
<td>S4SLL</td>
<td>Global Trade Services / Logistics Services</td>
<td>SLL</td>
</tr>
<tr>
<td>S4TRV</td>
<td>Travel</td>
<td>FI-TV</td>
</tr>
</tbody>
</table>
### Table 12: SAP S/4HANA Industries

<table>
<thead>
<tr>
<th>Name (System Alias)</th>
<th>Application Area</th>
<th>ACH</th>
</tr>
</thead>
<tbody>
<tr>
<td>S4FSCM</td>
<td>Insurance</td>
<td>FS-CM</td>
</tr>
<tr>
<td>S4ISA</td>
<td>IS Automotive</td>
<td>IS-A</td>
</tr>
<tr>
<td>S4ISAD</td>
<td>IS Aerospace &amp; Defence</td>
<td>IS-AD</td>
</tr>
<tr>
<td>S4ISEC</td>
<td>IS Engineering and Construction</td>
<td>IS-EC</td>
</tr>
<tr>
<td>S4ISPSCA</td>
<td>IS Public Sector Contract Accounting</td>
<td>IS-PS-CA</td>
</tr>
<tr>
<td>S4ISU</td>
<td>IS Utilities</td>
<td>IS-U</td>
</tr>
<tr>
<td>S4OIL</td>
<td>IS Oil &amp; Gas</td>
<td>IS-OIL</td>
</tr>
<tr>
<td>S4PSM</td>
<td>Public Sector Management</td>
<td>EA-PS</td>
</tr>
<tr>
<td>S4RFM</td>
<td>Retail Fashion Management</td>
<td>LO-RFM</td>
</tr>
</tbody>
</table>

### Table 13: SAP S/4HANA Add-Ons

<table>
<thead>
<tr>
<th>Name (System Alias)</th>
<th>Application Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>S4CPM</td>
<td>Commercial Project Management (Add-on)</td>
</tr>
<tr>
<td>S4PPM</td>
<td>Portfolio and Project Management</td>
</tr>
</tbody>
</table>

3. For each connection, enter the **Target Host** under Technical Settings and configure the settings under Logon & Security.

**Recommendation**

For the HTTP connection, we recommend to use HTTPS. Set the SSL option to **Active**.

**Note**

It is not mandatory to maintain an entry in the mapping table for each SAP system alias. If no table entry exists, the RFC connection resulting from a SAP system alias is calculated by adding the suffix _RFC, _HTTP, or _HTTPS to the SAP system alias.

### Example

There are two application systems:

- ERP (components FIN and LO)
- CAP (component CA)

The connections have to be mapped like this in the table **/UI2/SYSAliasMap** using the maintenance view **/UI2/V_ALIASMAP**:

<table>
<thead>
<tr>
<th>Client</th>
<th>Source System Alias</th>
<th>Target System Alias</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>S4FIN</td>
<td>ERP</td>
</tr>
<tr>
<td></td>
<td>S4LO</td>
<td>ERP</td>
</tr>
</tbody>
</table>

The following SM59 connections have to be created:
ERP_HTTPS (type H) points to ERP
ERP_RFC (type 3) points to ERP
S4CA_HTTPS (type H) points to CAP
S4CA_RFC (type 3) points to CAP

S4CA does not have to be mapped, because the SM59 connections conform to the naming conventions.

5.2.2.2 Replicate App Descriptors from Back-End System

To enable the access from the SAP Fiori launchpad to applications using Web Dynpro and SAP GUI for HTML technology, you have to replicate information about these applications from the back-end server to the front-end server. Each app has an app descriptor which provides this information.

You have to execute the replication before you enter the SAP Fiori launchpad designer to create your own catalogs. Only after the replication you will see the apps in the Technical Catalogs view.

Procedure

1. Launch the report /UI2/GET_APP_DESCR_REMOTE_ALL.
2. Mark the Test mode checkbox and choose Execute. The catalogs will not be replicated. A log is displayed.
3. If the log does not contain any errors, deselect the Test mode checkbox and choose Execute.

Recommendation

We recommend to schedule the report to run daily. As the report needs to run after every system update, scheduling the report ensures that you always have up-to-date information in the SAP Fiori launchpad designer.

More Information

For more information, see help.sap.com/s4hana_op_1610_002 ➔ SAP NetWeaver for SAP S/4HANA ➔ Function-Oriented View ➔ UI Technologies in SAP NetWeaver ➔ SAP Fiori Launchpad ➔ Administration Guide ➔ Setting Up Launchpad Content ➔ Integrating Web Dynpro and SAP GUI Applications Using Mass Maintenance ➔

5.2.3 Maintain Business Catalogs and Business Groups

The apps that are displayed to users on the SAP Fiori launchpad are organized by using catalogs and groups. Catalogs are the smallest entities that are assigned and authorized for your users, that is, from which a user can
choose. Groups define which apps are initially displayed on the SAP Fiori Launchpad entry page. You maintain catalogs and groups in the launchpad designer.

SAP delivers the following entities that help you maintaining your own, role-specific business catalogs and groups.

- **Technical catalogs, naming convention <...>_TC_<...>**
  Contain all target mappings and app launcher tiles relevant for apps per application area. As an administrator, you can use them as a repository to create your own role-specific business catalogs.

- **Business catalogs, naming convention <...>_BC_<...>**
  Business catalogs contain a sample collection of target mappings and app launcher tiles relevant for a business role. The content of the business catalog is a subset of the content of the technical catalog. This subset reflects the requirements of a specific business user. For the business catalogs that contain a specific SAP Fiori app, see the app-specific documentation.

- **Business group, naming convention <...>_BCG_<...>**
  Business groups contain a set of applications from a business catalog that are displayed to a user by default on the entry page of the SAP Fiori launchpad. Users can personalize groups by adding or removing apps from the SAP Fiori launchpad.

### Prerequisites

You have replicated the app descriptors for apps using Web Dynpro or SAP GUI for HTML. For more information, see Replicate App Descriptors [page 66].

### Procedure

1. Create your own catalogs by using the technical catalogs delivered by SAP as repositories.
2. Add SAP Fiori apps to your catalog.
   
   For SAP Fiori apps that are visible as tiles in the SAP Fiori Launchpad, you add the app launcher tile and a target mapping to the catalog. For SAP Fiori apps not visible as tiles, as for example object pages, you only add the target mapping to the catalog. Object pages correspond to business objects. They are started by navigating from other applications or by using the search. By choosing a business object representation in an app or a search result, users navigate to the corresponding object page.
3. You can also add Web Dynpro apps and transactions using SAP GUI for HTML technology to your catalogs. For more information, see Adding Web Dynpro and SAP GUI for HTML Apps to a Catalog [page 68].
4. Create a group to display specific apps to you users by default on the entry page of the SAP Fiori launchpad.
5. Add SAP Fiori apps from your catalogs to the group.
   
   For more information about the above steps, see [SAP NetWeaver for SAP S/4HANA Function-Oriented View UI Technologies in SAP NetWeaver SAP Fiori Launchpad Administration Guide Setting Up Launchpad Content Setting Up Content With the Launchpad Designer](http://help.sap.com/s4hana_op_1610_002).
6. Assign groups and catalogs to users’ PFCG roles on the front-end server. For more information, see Create PFCG Role on Front-End and Assign Launchpad Catalogs and Groups. [external document]
5.2.3.1 Adding Web Dynpro and SAP GUI for HTML Apps to a Catalog

Using the launchpad designer, you can add Web Dynpro apps and SAP GUI for HTML apps to your catalogs. These apps are included in technical catalogs and business catalogs delivered by SAP and their tiles and target mappings are correctly set up in the launchpad designer. However, as you will most probably define your own catalogs, you will find in the following how to add apps to your catalogs which use Web Dynpro or SAP GUI for HTML technology.

Prerequisites

You have already created your own catalog in the launchpad designer.

You require the following data for each app:

- Semantic Object
- Action
- Technical Catalog

To find out the technical catalog an application is assigned to, you have to check the table SUI_TM_MM_APP which contains all available app descriptors. Proceed as follows:

1. Call up transaction SE16.
2. In the field Table Name, enter SUI_TM_MM_APP.
3. Click on Table Contents or press  F7 .
4. Click on Execute or press  F8 .
5. Search for the relevant entries in the following rows:
   - For Web Dynpro applications: WD_APPL_ID and WD_CONF_ID
   - For SAP GUI for HTML applications: TCODE

The name of the technical catalog can be found in the row CAT_ID.

If you cannot find the application, you can add an app descriptor to your own technical catalog. Afterwards, you have to replicate the app descriptor from the back-end system. For more information, see Replicate App Descriptors from Back-End System [page 66].

Procedure

1. In the Implementation Guide (IMG) on the front-end server, choose SAP NetWeaver › UI Technologies › SAP Fiori › Adding Apps to SAP Fiori Launchpad (Using SAP Fiori Launchpad Designer) › SAP Fiori Launchpad Designer (Current Client) or open the following URL in your web browser:
   

2. Select the Catalogs view in the top left corner and choose the catalog to which you want to add the apps.
   
   The launchpad designer displays the tiles of the apps from this catalog on the right-hand side.

3. Choose Tiles.
   
   The launchpad designer displays all tiles in the selected catalog.

4. Select the app you want to add to your catalog and click Create Reference.
5. Enter the catalog you want to add the app to.
6. Choose **Target Mapping**.
   The launchpad designer displays all target mappings in the selected catalog.
7. Select the corresponding target mapping and click on **Create Reference**.
8. Enter the catalog you want to add the app to.
   The launchpad designer displays the **Configure Target Mapping** screen.
9. Call the catalog you entered before and make sure that the tile and the corresponding target mapping are included in the catalog.

### 5.2.4 Create PFCG Role on Front-End and Assign Launchpad Catalogs and Groups

You must perform this task and the following authorization- and role-related tasks on the front-end server to equip the user with the UI access to apps and the start authorizations for the activated OData services used by the apps.

We recommend adding the relevant catalog and the start authorizations for the activated OData services used by the apps in the catalog to the role menu of the same PFCG role. Thereby, you keep the UI access provided with the catalogs together with the needed start authorizations. If available, the system determines the OData services for a catalog and automatically includes the start authorizations when you add the catalog to the role menu.

Adding single OData service authorizations provides additional security, especially if the front-end server is set up as a separate hub. By specifying the services explicitly in the role menu, you control which requests on behalf of a user can pass SAP Gateway.

As an alternative, it is possible to authorize all activated OData services by specifying a wildcard for the start authorization check on the front-end server (*S_SERVICE = * (asterisk)).

**Caution**

If you use a wildcard, users can call all activated services. We therefore recommend not using wildcard authorizations in productive environments but adding single OData service authorizations.

### Prerequisites

You have activated the OData service and have called it at least once before assigning start authorizations. For more information, see **Front-End Server: Activate OData Services** [external document].

### Procedure

1. Open transaction **Role Maintenance (PFCG)**.
2. Create a new single role and assign the following in the role menu:
   - Type **Catalog**
   - Catalog Provider **Fiori Launchpad Catalogs**
○ Catalog ID
○ Optional (if the users should see the tiles in a group already on the SAP Fiori launchpad start page): Type Group, Group ID

Alternatively, you can copy the template business role delivered by SAP, which already contains the catalog and group, as sample content to your customer namespace.

3. To automatically enter the OData services, if available:
   ○ Select the Local Front-End Server radio button.
   ○ Mark the Include Applications checkbox.

4. To manually enter the OData services, for example, for analytical apps that are launched by using a KPI tile, do the following:
   1. Add the following in the (new or copied) role menu for each of the OData services:
      ○ Type Authorization Default
      ○ Authorization Default TADIR Service
      ○ Object Type IWSG - Gateway: Service Groups Metadata
   2. Select TADIR Service using value help for the object name with <name of activated service>.
   3. Enter the name as follows: <technical name>_<four-digit version number with leading zeros>.
      For more information about how to determine the OData service name for apps, see Front-End Server: Activate OData Services [external document].

5. Save the role menu, and go to the role authorization, change the authorization data, and adopt the generated authorizations accordingly.

6. Generate the authorization profile and save it.

**Note**

When a catalog is changed in the launchpad designer, for example, an app is added or removed, you must update the start authorizations for the services in the front-end system. If you added the catalogs to the front-end PFCG roles and included the applications, you can determine the roles that must be adapted by using the PRGN_COMPARE_ROLE_MENU report.

In Role Maintenance (PFCG), you compare and update the roles to reflect the authorizations changes as given in the current definition of the catalog.

However, the comparison (both using the report or comparing in PFCG) does not include applications or services that you added manually to the role menu.


### 5.2.5 Assign Roles to Users

You have to assign the roles on the front-end server with the catalogs, groups, and OData start authorizations to users.
Procedure

1. In transaction **Role Maintenance (PFCG)** on the **User** tab, assign the role containing the catalogs, groups, and OData start authorizations to a user by specifying the user ID. Thereby, the user has UI access to the apps in the catalogs and the start authorizations for the respective OData services on the front-end server.

### 5.3 Implementation Tasks on Back-End Server

This section contains the tasks you perform on the back-end server to implement SAP Fiori apps.

**Note**

User names in the ABAP back-end server must be identical to the corresponding user names in the ABAP front-end server. User mapping is not supported. For this purpose, you can use Central User Administration (CUA) or identity management systems.

### 5.3.1 Web Dynpro Apps and SAP GUI for HTML Apps

#### 5.3.1.1 Activate ICF Services of Web Dynpro Apps

To call a Web Dynpro app, you use a dedicated URL, which accesses your back-end system.

A component called the **Internet Communication Framework (ICF)** runs on your back-end system. The URL calls a service in the ICF (**ICF Service**). The ICF service executes one or more ABAP programs to compile the requested data and returns it to the web browser.

Each Web Dynpro app uses its own ICF service. For security reasons, all ICF services initially are inactive and have to be activated first.

**Note**

We recommend that you only activate the services for the apps you want to use.

#### Prerequisites

You have collected the following information from the SAP Fiori apps reference library:

- **WebDynpro Component Name**
  
  This name specifies the **app-specific ICF service**.

#### Procedure

Activate the ICF services of your Web Dynpro app on your **back-end server**. In the **HTTP Service Hierarchy Maintenance** transaction, you find the ICF service under the path `/default_host/sap/bc/webdynpro/sap/`
To activate an ICF service, proceed as follows:

1. Choose Tools > Administration > Network > HTTP Service Hierarchy Maintenance or start transaction SICF.

2. You are on the Define Services screen. The system defaults the Hierarchy Type SERVICE. Choose (Execute) or press F8.

3. You are on the Maintain service screen, which offers a filter area called Filter Details.
   Enter the name of the ICF service you want to activate in the ServiceName field in the Filter Details screen area and choose (Apply).

   **Note**
   If you know the path of the ICF service, you can also navigate to it in the Virtual Hosts / Services screen area.

4. The system filters the service hierarchy in the Virtual Hosts / Services screen area for the path leading to the filtered ICF service. Highlight the ICF service and choose Service/Host > Activate.

5. The Activation of ICF Services dialog box appears.
   Choose (Yes) to activate the selected service including all the sub services.

### 5.3.1.2 Activate ICF Services for SAP GUI for HTML

You have to activate ICF services to enable the start of SAP GUI for HTML. You have to do this once for all SAP GUI for HTML apps.

**Procedure**

1. Start transaction SICF.

2. Choose (Execute).

3. In the Virtual Hosts/Services area, navigate to the following services, and choose Service/Host > Activate for each:
   - /sap/bc/gui/sap/its/webgui
   - /sap/bc/apc/sap/webgui_services
   - /sap/bc/gui/sap/its/typeahead

4. In the Activation of ICF Services dialog box, choose (Yes) to activate the selected service including all the sub services.
5.3.1.3 Optimize the Fiori Launchpad Embedding for SAP GUI for HTML Apps

The following settings are recommended for embedding GUI-based functionality in the Fiori Launchpad in an optimized way.

Prerequisites

You have activated the ICF node /sap/bc/gui/sap/its/webgui.

Procedure

1. In transaction SICF, create an external alias for /sap/bc/gui/sap/its/webgui.
2. Set the following service Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>~SINGLETRANSACTION</td>
<td>1</td>
<td>Window session is closed after starting transaction is left. In combination with the below logoff handler, this is used to close the window automatically after a transaction completes. This mode can cause certain transactions to close without showing a success message even though the document was processed successfully. If your scenarios are affected by such cases, consider changing this parameter value to 0.</td>
</tr>
</tbody>
</table>
| ~WEBGUI_SIMPLE_TOOLBAR      | 7918  | Bitmap for customizing the toolbar:  
  - Bit 0 = 0: Standard settings (equals to Bits 1/2/5 set)  
  - Bit 1 = 1: Title Bar shown  
  - Bit 2 = 1: "Cancel" and "Help" buttons shown  
  - Bit 3 = 1: Turns on Tools Buttons (e.g. "Back", "Print")  
  - Bit 4 = 0: Separate system menu  
  - Bit 5 = 1: Application Button bar  
  - Bit 6 = 1: Show the Standard Menu below a button |
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit 7 = 1:</td>
<td></td>
<td>Setting this bit turns off the information tab (System, User) in the status bar</td>
</tr>
<tr>
<td>Bit 9 = 1:</td>
<td></td>
<td>it 9 = 1: no System Menu Bit</td>
</tr>
<tr>
<td>Bit 10 = 1:</td>
<td></td>
<td>B 10 = 1: no Help Menu</td>
</tr>
<tr>
<td>Bit 11 = 1:</td>
<td></td>
<td>Bit 11 = 1: no OK Code field</td>
</tr>
<tr>
<td>Bit 12 = 1:</td>
<td></td>
<td>Bit 12 = 1: No F1 Help</td>
</tr>
</tbody>
</table>

Note
Certain transactions may require usage of functions in the system menu, so you may want to consider to leave Bit 9 set to 0 (corresponding to value 7406).
For more information, see SAP Note 1010519.

- ~WEBGUI_ICON_TOOLBAR
  2
  Shows button icons instead of text.

- ~XSRFCHECK
  1
  Cross Site Request Forgery Check support of WebGUI enabled.
  For more information, see SAP Note 1481392.

- ~THEME
  sap_bluecrystal
  Default theme is set to Blue Crystal (mainly takes effect when run in standalone mode).

- ~WEBGUI_DLGAREA2
  0
  Do not show the Personas SAPGUI-like menu header, instead use simplified look.

- ~WEBGUI_DLGAREA2_MBAR
  0
  Do not show the Personas SAPGUI-like menu header, instead use simplified look.

- ~WEBGUI_CONTEXTMENU
  0
  Disable context menu (does not disable keyboard shortcuts)

- ~WEBGUI
  1

- SAP-IE
  edge
  Force Microsoft Internet Explorer to make use of edge mode.

- ~NO_DOMAIN_RELAXING
  1
  Deactivate domain relaxation

3. In addition, define a logoff handler page to automatically close the window. Under Error Pages, choose Logoff Page and enter the following:
5.3.2 Assign RFC Authorization to User

If the OData back-end service is located on a remote back end, users need permission to perform the RFC call on the back-end system.

Prerequisites

You have created a user on the front-end system.

Procedure

1. In the User Maintenance transaction (SU01) under Information > Information System, check if the user has the required authorizations S_RFC and S_RFCACL for trusted RFC.
2. If the user does not have the authorizations, assign a role including the RFC authorization objects S_RFC and S_RFCACL to the back-end user that corresponds to the front-end user.

5.3.3 Create PFCG Role on Back-End

You must perform this task to equip the user in the back-end system with the authorizations required for the apps launched from SAP Fiori Launchpad. We recommend organizing the roles according to the roles on the front-end server for the catalogs.

The authorizations required for a particular application are provided via the application itself or via the OData service of the application in case of SAP Fiori apps. This includes the start authorizations for the service or the application in the back-end system and the business authorizations for accessing business data displayed in the app. By adding the application or OData service to the menu of back-end PFCG roles, you add the start
authorization and the authorization proposals for the business authorizations. You can adjust these according to your needs.

We recommend adding all applications and services required by apps of a certain catalog to the same role. If available, add the catalog to the role menu to automatically include the OData services, Web Dynpro and SAPGUI for HTML applications. You can create a new role or use an existing role that fits to the scope of the catalog. If you add the applications and services to an existing role, the authorization proposals have to be merged with the authorization values already defined in the role. You can consider using existing roles if the following applies:

- The same users assigned to the role shall get access to all apps in the catalog.
- The business authorizations already defined in the role and those that you define for the apps in the catalog do not contradict.

Procedure

1. Run transaction Role Maintenance (PFCG) and create a new PFCG role or edit an existing role.
2. To enter the catalog and, if available, automatically include the OData services, Web Dynpro and SAPGUI for HTML applications, on the menu tab open the menu of the pushbutton for adding objects and choose SAP Fiori Tile Catalog.
   - Select the Remote Front-End Server radio button and provide the RFC variable or the RFC destination to establish a connection to the front-end server.
   - Select the Include Applications checkbox.
   - Select the catalog for which the authorizations shall be included. The value help lists all catalogs available on the front-end server. The OData services, Web Dynpro applications and SAPGUI for HTML applications are added to the role menu as sub-nodes of the catalog.
3. To manually enter the OData services in a role, for example, for your custom analytical apps that are launched by using a KPI tile, do the following:
   1. On the Menu tab, open the menu of the pushbutton for adding objects (+ pushbutton) and choose the object type Authorization Default.
   2. From the Authorization Default menu, choose TADIR Service and enter the following data:
      - Program ID: R3TR
      - Object Type: IWSV
   3. In the table, enter the name of the OData service. For information about how to determine the OData service name for apps, see Front-End Server: Activate OData Services [external document].
4. To manually add Web Dynpro apps and SAP GUI for HTML apps, do the following:
   - Web Dynpro: On the Menu tab, open the menu of the pushbutton for adding objects (+ pushbutton) and choose the object type Web Dynpro Application. Enter the Web Dynpro application.
   - SAP GUI for HTML: On the Menu tab, open the menu of the pushbutton for adding objects (+ pushbutton) and choose the object type Transaction. Enter the transaction code.
5. Repeat steps 2 to 4 for all applications and services of the catalogs that you want to authorize with the role.
6. On the Authorization tab, choose the pushbutton next to Profile Name to generate the authorization profile for the role.
8. Choose Save and then Generate.
If the user does not yet have the business authorizations required to use the app, perform the following steps:

1. Open transaction **User Maintenance (SU01)**.
2. On the **Authorization** tab, choose **Generate Profile** next to the profile name.
3. Choose **Maintain Authorization Data**.
4. On the **Authorization Details** screen, choose the **Generate** symbol.

**Note**

When a catalog is changed in the launchpad designer, for example, an app is added or removed, you must update the start authorizations for the services in the back-end system and the business authorizations for accessing business data that are displayed in the app. If you added the catalogs to the back-end PFCG roles and included the applications, you can determine the roles that must be adapted by using the `PRGN_COMPARE_ROLE_MENU` report.

Alternatively, in Role Maintenance (PFCG), you can compare and update the roles to reflect the authorizations changes as given in the current definition of the catalog.

However, the comparison (both using the report or comparing in PFCG) does not include applications or services that you added manually to the role menu.


**Additional Steps for Object Pages**

If the catalog contains object pages, the authorization defaults contain the `S_ESH_CONN` (search connector) authorization object.

You must add entries to the authorization object `S_ESHCONN` in the subtree **Basis: Administration**. Fill the following fields:

- **Request of Search Connector**
- **Search Connector ID**
- **System ID**
- **Client**

For the values, see the app-specific documentation.

**5.3.4 Assign Roles to Users**

You have to assign the roles on the back-end system to users.

**Procedure**

In transaction Role Maintenance (PFCG) on the **User** tab, assign the role by specifying the user ID. As an alternative, run the User Maintenance transaction (SU01) and assign the role to the user. Thereby, the user has the authorizations for the apps in the catalog.
5.3.5  Create Search Connectors for Object Pages on Back-End Server

To enable the use of a specific object page, the underlying search model(s) must have been activated.

When activating a search model, a search connector is created. A connector is the runtime object corresponding to the search model. It is system-specific and client-specific.

When available, the search models that need to be activated for your app are listed in the app-specific implementation information and are present in the authorization defaults of the OData services, see Maintain Authorization Default Values (SAP) (SU22). For more information, see the app-specific documentation.

Prerequisites

The SAP Fiori search has been set up. For more information, see Setup of SAP Fiori Search [page 45].

Activities

For each app, create the search connectors in transaction ESH_COCKPIT in your back-end system. For more information, see Setup of SAP Fiori Search [page 45] and then Activities Setup of SAP Fiori Search in the Back End 6. Create connectors .

5.4  Creating Custom Analytical Apps Using a KPI tile

For the analytical apps that are launched by using a KPI tile, you can create custom apps by performing the following tasks:

1. Modeling KPIs [page 78]
2. Configuring Targets for KPIs [page 79]

5.4.1  Modeling KPIs

If an analytical app is launched by using a KPI tile, you can define new KPIs or adapt predefined KPIs to determine what information is displayed and how it is visualized in the tile. To enable users to model KPIs based on their requirements, SAP provides the SAP Smart Business modeler apps.

You can model your own KPIs according to your business needs and activate them. SAP also delivers predefined KPIs that do need modeling but do not need activation as they are delivered in an active state.

For information about whether your app is launched by using a KPI tile, see the app-specific documentation.
Prerequisites

- You have installed the SAP Smart Business modeler apps on the front-end server.
- Your user is assigned to the SAP Smart Business modeler apps. The business role SAP_BR_ANALYTICS_SPECIALIST contains the catalog and group provided by SAP. To run these apps, users need the authorizations for the OData service SMART_BUSINESS_DESIGNTIME_SRV. We recommend that you define a role on front-end server using the SAP delivered catalog and group as described in Create PFCG Role on Front-End and Assign Launchpad Catalogs and Groups [external document] and a corresponding role on the back-end server as described in Create PFCG Role on Back-End [external document].

Activities

Model KPIs according to your requirements.

Note
You can use the entities provided by SAP as templates for your own KPIs.
To do so:
1. Copy the KPIs to your own namespace by using the KPI Workspace app.
2. Re-create any evaluations and tiles in your own namespace.
3. Adapt the objects according to your needs.

More Information

- For more information about modeling KPIs, see SAP Help Portal at help.sap.com/s4hana_op_1610_002 Product Assistance > Cross Components > Analytics > SAP Smart Business Modeler Apps.
- For more information about drill-down applications for KPIs, see SAP Help Portal at help.sap.com/s4hana_op_1610_002 Product Assistance > Cross Components > Analytics > SAP Smart Business Modeler Apps > Configure Drill-Down.
- For information about whether an app uses a KPI tile, see the app-specific documentation for SAP Fiori apps.

5.4.2 Configuring Navigational Targets for KPIs

For KPIs that you modeled in the SAP Smart Business modeler apps, you can specify navigational targets by defining target mappings. When a user opens a tile to view more details or to perform additional tasks, the target defines what application is opened.

Note
Configuring navigational targets is mandatory for all KPIs that you created by using the SAP Smart Business modeler apps. For KPIs that are delivered as part of the app-specific content, navigational targets are already
defined. However, if you want to specify different targets or use custom applications as targets, you can customize or extend the provided content.

You can configure different target mappings for different KPIs and assign the target mappings to different PFCG roles. By specifying targets based on roles in this way, you can control where users are directed according to the type of information they need to view and the tasks they need to perform based on their job. For example, you can configure two role-based targets for one KPI so that the application opened for managers is different from the application opened for accountants.

SAP Fiori launchpad determines the navigational target for a KPI based on the combination of the semantic object and the semantic action that are associated with a KPI.

Prerequisites

- You have made any required custom applications available for use as targets.

Procedure

For determining the navigational target, the following rules apply:

<table>
<thead>
<tr>
<th>Component</th>
<th>Technical Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Semantic Object</td>
<td>Specify the semantic object for a KPI in the SAP Smart Business modeler apps.</td>
</tr>
<tr>
<td></td>
<td>For the technical name of the KPIs used by the SAP Fiori apps, see the app-specific documentation.</td>
</tr>
<tr>
<td></td>
<td>If there are no entries in the <strong>Semantic Object</strong> fields, the KPI measure name is used a semantic object.</td>
</tr>
<tr>
<td>Semantic Action</td>
<td>Specify the semantic action for a given KPI in the SAP Smart Business modeler apps.</td>
</tr>
<tr>
<td></td>
<td>If there are no entries in the <strong>Action</strong> fields, the default value is <code>analyzeSBKPIDetailsS4HANA</code>.</td>
</tr>
</tbody>
</table>

SAP provides a fallback configuration that uses the generic drill-down app as navigational target; this is valid for all semantic objects and semantic action `analyzeSBKPIDetailsS4HANA`. Therefore, only if you want to use another drill-down app for certain KPIs, you need to configure navigational targets.

For more information about how to configure a target for a KPI, see the SAP Help Portal at [help.sap.com/s4hana_op_1610_002](https://help.sap.com/s4hana_op_1610_002) > SAP NetWeaver for SAP S/4HANA > Function-Oriented View > UI Technologies in SAP NetWeaver > SAP Fiori Launchpad > Administration Guide > Setting Up Launchpad Content > Setting Up Content With the Launchpad Designer > Setting up Navigation > Configuring Target Mappings.
6 Extensibility

SAP S/4HANA natively embodies key user in-app extensibility tools, offering the means to change and adapt the UI layout and context, create custom fields, create and extend analytical reports and forms, and change the business logic. With SAP S/4HANA, you can implement in-app extensions satisfying all extensibility qualities. In particular, end-to-end tools enable business experts to apply changes without risk, as the technical complexity is reduced to a level that corresponds to the business purpose and is stable and fault tolerant. Thanks to a strict tool-based approach, these extensions are loosely coupled with core business processes and contribute to a pace-layered IT.

In addition, the UI development toolkit for HTML5 (SAPUI5) offers you a broad range of means for adapting SAP Fiori apps to your specific requirements.

6.1 Adapting the User Interface

Key users can adapt the user interface (UI) of their apps at runtime in a modification-free way, for example, by adding, removing, or moving fields and groups. Runtime adaptation is supported for apps that use SmartForm controls with stable IDs. Note that you can only add fields which have been made available for this app. If you need additional fields, you have to create them as described under Creating Custom Fields and Custom Business Logic.

More Information

For more information, see SAP Help Portal at help.sap.com/s4hana_op_1610_002 ➤ SAP NetWeaver for SAP S/4HANA ➤ Function-Oriented View ➤ UI Technologies in SAP NetWeaver ➤ SAP Fiori Launchpad ➤ User Guide ➤ Using the Launchpad ➤ Adapting SAP Fiori Uls at Runtime ➤.

6.2 Creating Custom Fields and Custom Business Logic

Field extensibility refers to the capability to add customer-specific fields (custom fields) to a business context of an application (for example, a sales order item or a customer address) in a one-to-one relation. After the field has been defined, all necessary software artifacts are generated by the extensibility tool: SAP database tables and application structures are enhanced by using the “DDIC extension include” concept. Assigned SAP core data service (CDS) views, SAP Fiori search, and OData services are extended as well. As the applications are prepared for this kind of extensibility, they do consider these extension fields in their business logic, so the generated fields can be used directly.

Business logic extensibility refers to the enhancement of the behavior of applications and processes. You can enhance a modifiable application at a designated point to implement your custom logic.

You use the Customer Fields and Logic app to implement these extensions.
More Information

For more information, see SAP Help Portal at help.sap.com/s4hana_op_1610_002 ➔ SAP NetWeaver for SAP S/4HANA ➔ Function-Oriented View ➔ General Functions for the Key User ➔ Extensibility ➔.

6.3 Adding Custom Views

To extend views, you use extension points. These constitute anchor points for extensions. To activate an extension point, you insert the SAPUI5 control `< core:ExtensionPoint / >` into an SAP-shipped HTML5 application based on an XML-type view. Extension points are documented and kept stable. This means that any extensions plugging in are more robust across application updates.

More Information

For more information, see SAP Help Portal at help.sap.com/s4hana_op_1610_002 ➔ SAP NetWeaver for SAP S/4HANA ➔ Function-Oriented View ➔ UI Technologies in SAP NetWeaver ➔ SAPUI5: UI Development Toolkit for HTML5 ➔.
- ➔ Extending Apps ➔ View Extension ➔
- ➔ Essentials ➔ Model View Controller (MVC) ➔ Views ➔ XML Views ➔

6.4 Adapting Database Extensions to SAP S/4HANA

When you convert your system from SAP Suite on HANA to SAP S/4HANA 1610, modifications to the SAP HANA database remain unchanged. However, to make your modifications visible on the UI, manual steps can be required in different content layers.

Procedure

1. If required for your modifications, adapt the relevant Core Data Service (CDS) views in the SAP Business Suite layer. You can extend CDS views by using ABAP development tools. For more information, see help.sap.com/abapdocu_740/en/index.htm ➔ ABAP Keyword Documentation ➔ ABAP Dictionary ➔ ABAP CDS in ABAP Dictionary ➔ ABAP CDS - Views ➔ ABAP CDS - DDL Statements ➔ ABAP CDS - EXTEND VIEW ➔.

2. If required for your modifications, adapt the OData services for your CDS views in the SAP NetWeaver Gateway layer:
   ○ For OData services that are included in a CDS view definition as an annotation, the relevant artifacts are generated automatically. No modifications are required in the SAP NetWeaver Gateway layer. For more information, see help.sap.com/s4hana_op_1610_002 ➔ SAP NetWeaver for SAP S/4HANA ➔ Function-Oriented View ➔ Application Server ➔ Application Server ABAP ➔ Application Development on AS.
OData services that are not included in a CDS view definition must be redefined in Service Builder. For more information, see help.sap.com/s4hana_op_1610_002 SAP NetWeaver for SAP S/4HANA Function-Oriented View SAP Gateway Foundation (SAP_GWFND) SAP Gateway Foundation Developer Guide SAP Gateway Service Builder Data Modeling Basics Data Modeling Options Redefining Services.

3. If available for your app, you can use runtime adaptation to add, move, or remove view fields in the UI layer. For more information, see Adapting the User Interface [page 81]. As an alternative, you can extend views by using SAP UI5 extension points. For more information, see help.sap.com/s4hana_op_1610_002 SAP NetWeaver for SAP S/4HANA Function-Oriented View UI Technologies in SAP NetWeaver SAPUI5: UI Development Toolkit for HTML5 Extending Apps View Extension.
# Typographic Conventions

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;Example&gt;</code></td>
<td>Angle brackets indicate that you replace these words or characters with appropriate entries to make entries in the system, for example, “Enter your <code>&lt;User Name&gt;</code>”.</td>
</tr>
<tr>
<td>Example Example</td>
<td>Arrows separating the parts of a navigation path, for example, menu options</td>
</tr>
<tr>
<td>Example</td>
<td>Emphasized words or expressions</td>
</tr>
<tr>
<td><a href="http://www.sap.com">www.sap.com</a></td>
<td>Textual cross-references to an internet address</td>
</tr>
<tr>
<td><code>/example</code></td>
<td>Quicklinks added to the internet address of a homepage to enable quick access to specific content on the Web</td>
</tr>
<tr>
<td>123456</td>
<td>Hyperlink to an SAP Note, for example, SAP Note 123456</td>
</tr>
</tbody>
</table>
| Example | • Words or characters quoted from the screen. These include field labels, screen titles, pushbutton labels, menu names, and menu options.  
• Cross-references to other documentation or published works |
| Example | • Output on the screen following a user action, for example, messages  
• Source code or syntax quoted directly from a program  
• File and directory names and their paths, names of variables and parameters, and names of installation, upgrade, and database tools |
| EXAMPLE | Technical names of system objects. These include report names, program names, transaction codes, database table names, and key concepts of a programming language when they are surrounded by body text, for example, `SELECT` and `INCLUDE` |
| EXAMPLE | Keys on the keyboard |